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Introduction
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υ Introduction

Thank you for choosing Microspot Interiors, the affordable, easy to use 3D modeling ap
tion for the Apple Macintosh® computer. Designed for novices as well as professionals, 
Microspot Interiors provides the tools you need to create realistic 3D interior designs.

υ Entering serial number

The first time you run Interiors you will be asked to enter your serial number

υ Welcome screen

The welcome screen allows new users to register Microspot Interiors. Registering the pr
allows you to receive technical support, as well as upgrade and new product information

• Never register: Allows you to skip registation and starting using the 
Microspot Interiors. The welcome screen will not appear again.

• Register later: Allows you to skip registation and starting using the 
Microspot Interiors. The welcome screen will appear the next time Interior 
is started.

• Register now: Opens your default browser to the Microspot Interiors regi-
sation page. The welcome screen will not appear again.

Note: If you would like to register but press the Never register button, please use the help
item Registration Information. (see Registration Information on page 3-36 for more informa
tion).
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υ Technical Support

You must register your product in order to receive technical support, as well as upgrade
new product information. Registration information is provide in the help menu or please 
the contact information below: 

Address: Microspot Limited
Concorde House
10-12 London Road
Maidstone Kent ME16 8QA
England

Phone: 01622-687771; International: + 44-1622-687771
FAX: 01622-690801; International: + 44-1622-690801

Email: support@microspot.co.uk
Web: www.microspot.co.uk
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Chapter 2

Tutorial

A brief introduction to some of Interiors’s features and tools.
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The following tutorial takes you through the process of designing an irregularly shaped r
and placing doors, windows, furniture, accessories and lighting objects within it. Colors a
textures are then applied to the walls and furniture, and the various light settings are adju
create a realistic scene. A final render is then produced and a picture saved and/or print

Once you are familiar with the tools and methods discussed here, you can easily use th
design and make-over your own rooms, so interior design is effortless, risk free and fun!

υ Getting Started

Launch Interiors

Double-click on the Interiors icon to launch the application. A new untitled document will
play along with the Tools and Help palettes and the application menu bar:

Tools Palette

Help Palette

Menu Bar

Document Window

Document NameDocument View

Document Grid

Zoom Out
Zoom In

Change View Popup Menu

Info Palette
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The Tools Palette

Familiarize yourself with the tools available in the Tools palette. Click on a tool (other tha
top four tools) and hold down the mouse button to display the name of that tool. Look at
Help palette for brief advice on using the selected tool.

Note: The window view may change and various palettes open according to the tool sele
When you have finished looking at the tools available, select the Arrow tool, close all pa
except for the Tools and Help palettes (by clicking on the palette’s top left corner), and s
Home View from the Change View submenu in the View menu.

Arrow

Rectangular Marquee

4 Walls

Animation Draw Path

Light Director

VR

Rotate

Hand

Walls

Animation Edit Path

Sun Direction

Gravity

Walkthrough

Scale Object

Viewfinder

Point Light

Spot Light

Orbit
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Setting the Grid Options

Before beginning to design your room, you must first specify the drawing environment. G
the Options menu and ensure that there is a checkmark next to the Metric option. If there
select Metric from the menu to specify that metric units of measurement should be used

Select Grid Options from the Options menu set the Grid Options as shown below and cl
OK:

Resize the Window

If you wish to change the window size, click on the bottom right corner of the window an
with the mouse button held down, drag to make the window smaller or larger.

Note: The smaller the window size the faster the view is rendered.

Save the Document.

Select Save from the file menu to save the document. In the dialog that displays, specify
tion to save the file and give it the name Tutorial A.
2-5
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υ Navigating

Before we begin constructing the tutorial room, it is useful to get familiar with the NaviCa
palette. Select NaviCam palette from the Palettes menu: 

The red square displayed in the palette, both in the height area and in the position plan,
sents the camera. The line from this square shows the camera view direction and at the
this line is the look at point or point of interest.

• In the Position Plan, click on the camera square and drag to change the 
position of the camera. Click on the view direction line and drag to change 
the view direction.

• In the height area move the camera up and down to change the camera 
height or move the view direction line to look up and down.

• If necessary, click on the Zoom button and drag up or down to zoom in and 
out of the scene.

Note: Zooming large amounts can often cause distortion. For large changes move the ca
forward or backward to change the view. Keep the NaviCam palette open whilst doing th
tutorial so if your view is obstructed you can re-adjust the camera position or viewing an

Height Area

Grid Height

Zoom

Clipping Planes

Position Plan

Position Buttons
2-6
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υ Drawing the Walls of the Room

We are going to draw a double bedroom with bathroom. To draw a rectangular room wit
four walls you would use the 4 Walls tool, to draw this less regular room will use the Wal
tool:

Set the Wall Options

Hold down the Option key (alt) and click on the Walls tool to display the Wall Options dia
Enter 100 as the Wall thickness and 2300 as the Wall height. These are the default settin
will be used for any walls drawn until these settings are changed. Click OK.

Draw the Walls

Below is the plan showing the dimensions in millimeters of the room we are going to dra

Note: We will first draw the exterior walls of the general structure followed by the construc
of the bathroom walls.
2-7
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Note: Dimensions are of internal walls.

1. Select the Walls tool in the Tools palette. The document view changes to an ortho
plan view, as this is the easiest view to use when drawing walls. 

2. Click towards the top left of the grid then move the cursor towards the right of the 
to draw the north wall.

6500

4500

6500

4900
2750

3250

2000

1600
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3. When the wall is about the right length, click again. The Edit options dialog will dis
play. The height and thickness of the wall are determined by the value you entere
the Wall options earlier. Enter a value of 6500 in the Length field and click OK.

4. The first wall is drawn on the grid. Move the cursor towards the bottom to draw the
ond wall perpendicular to the first wall. 
2-9
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5. Click again to mark the approximate position of the end of the second section of t
wall. The Edit options dialog displays again. Enter 6500 as the Length and click O

Continue in this way to draw the remaining walks referring to the plan shown at the begi
of this section for the wall measurements.

• If you make an error press the Delete key to undo the last wall section 
drawn.

• To avoid displaying the Edit Options dialog hold down the Option key (alt) 
when clicking to mark the end point of a wall
2-10
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6. When you have drawn the final wall click Done in the Edit options dialog. This will
now take you to the Home View. 

7. Using the same Wall tool, we will draw the bathroom walls anywhere on the grid a
rearrange the precise position later on.

8. Draw the bathroom walls and click Done at the end of the second wall:
2-11
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9. Once you have finished the construction of the bathroom walls, select Plan View f
the view menu. Select the L shaped walls and you will notice on the info palette, th
Y and Z position are automatically locked:

10. Click on the X and Z padlock to unlock the position of the walls' axis. We can now
reposition the unlocked walls to the right position by clicking and dragging them to
correct position:

Once the internal walls have been positioned as illustrated in the plan, you can avoid ac
tally moving them by locking the X and Z coordinates.

Grid Snapping

Grid Snapping applies an invisible grid to the document to which object points can snap
distance between the nodes on this grid are determined by the value entered for the Sn
Grid Distance in the Grid Options dialog.
2-12
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Grid Snapping is switched on and off in the options menu. This option is automatically tu
off when the program begins. As we do not need Grid Snapping in this example, if you h
put it on, select it in the Options menu to turn off:

Change to the Top View

Select Top View from the View popup menu at the bottom of the document window, or fr
the Change View submenu in the View menu, to display a top view of the document:
2-13
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Rotate the Grid

Select the Rotate tool in the Tools palette, click on the grid and drag while holding down
mouse button. This allows you to rotate the grid so that you can look at the room you ha
drawn.

Note: Hold down the Shift key when rotating the grid to constrain it to its initial plane.

Return to the Home View by selecting its name in the View popup menu at the bottom of
document window or from the Change View submenu in the View menu.

Save the Document

Select Save from the File menu or press Command-S to save the document.

υ Add a Floor

1. With the Arrow or Rotate tool selected click on a wall to select it

Note: When an object is selected it is surrounded by a bounding frame with handles at th
points where the bounding lines intersect. (As you are inside the room, the bounding fra
may not be visible in this instance.) 

2. Choose Floors from the Plug-in menu.
2-14
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3. A floor will be added to the room:

Note: Floors are drawn in such a way that they can only be seen from above. If you rotat
grid and view the room from below, the floor will be invisible, although the floor object is 
present.

Save the document.

υ Add Windows and Doors

Return to home view and use the NaviCam to change the camera position and viewpoin
that you are looking at the bottom left corner of the room:
2-15



   
Selecting the Windows and Doors Palette

Bring up the Windows and Doors palette from the Palettes menu.
2-16
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Click on the title bar of a palette and drag, holding down the mouse button, to reposition

Adding a Door

Open the Library Palette from the Palettes menu. Select the Doors library by clicking on
Display menu to view all the libraries. To find a specific object, start typing its name into 
Find field at the top right of the palette and watch for the name to appear in the comment
In this example we will use an embossed red door

The first item with a name starting with e is Embossed Red Door. Embossed Red Door 
selected and highlighted by a black frame around its preview icon. The selected item's f
name displays in the Comments field at the bottom right of the palette.

Holding the mouse button down on the selected door, drag it across to the wall in your c
view. Release the mouse button to drop the door in the wall. The door will be placed in th
and the Windows and Doors palette will show its dimensions and position in the wall.
2-17
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Note: If the Windows and Doors palette is not visible (it may be beneath another palette)
play it by selecting its name in the Palettes menu.

Position the Door

With the door still selected, you can edit the position of the door from either end of the wa
this case we will place the doors in the centre of their walls, by clicking the Centre in wa
ton in the palette. You will notice the door repositions itself automatically.
2-18
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Using the same method, place another door for the smaller room opposite the door we p
earlier, and centre it on the wall.

Adding the Patio Door

Use the NaviCam palette to change the view so that you are looking at the north wall. T
time we will drag and drop the Patio Door on to this wall.
2-19
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With the door still selected, enter 850 in the field specifying the distance of the door from
right end of the wall. Press the Enter key. Leave the other dimensions at the default or c
lated values.

Add a Window

We need to reposition the NaviCam to place the camera inside the smaller room, with a v
the west wall.
2-20
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Find the Inset Double Sash window:

Drag and drop the selected window onto the wall in view. The Windows and Doors palet
plays the window's dimension and position information:

Reposition the window by entering 400 in the field specifying the distance of the window 
the right end of the wall. You an adjust the height of the window by entering your desired
2-21
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height into the bottom right field; in this case we will set it at 996. Press the Enter key af
entering the information in each field.

Save a View

Change the view using the NaviCam palette, position the camera at the bottom right cor
the entire room and looking towards the patio door. Click on the button marked with a m
fying glass and drag down to zoom out from the scene if necessary:

Select Name View from the View menu. In the Name View dialog, enter Bedroom View a
click OK:
2-22
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Save the document.

υ Add Furniture

The next stage is to furnish your room.

Change your current view to Top View from the View menu and select the Nudge palette
the Palettes menu. 

This palette allows you to easily move and rotate items. Reposition the palette on the sc
necessary.
2-23
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Add a Bed

Select the Bedroom library from the Library palette. This will display all bedroom furnish
available:

Find the White/Pine Double Bed by typing the name in the Find field, and press the Ente
to see the icon highlighted. Click on the bed icon and hold down the mouse button, mov
cursor over the floor of the room and when the mouse is over floor release the mouse bu
drop the bed onto the floor.

Either select the arrow tool and click and drag on the bed to move it, or use the Nudge p
to move it by a specified amount.
2-24
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Use the Nudge Palette

Select the bed in the document window.

Enter a value in the move box in the Nudge palette. The units will be millimeters as set f
document at the beginning of the tutorial.

Click on the control buttons to choose direction in which to move the selected object. Th
directions relates to the current view. 

Note: You will not be able to move the bed closer or further away (when looking at a top v
as it is constrained to stay on the floor. 

Use the Nudge palette to rotate the bed:

1. Select the bed in the document window.

2. Enter a value of 90° in the Rotate Box in the Nudge palette.

3. Click on the Rotate Clockwise button to rotate the bed so that the headboard is cl
to the east wall.  

Note: You will not be able to rotate the bed other than clockwise and anti-clockwise (whe
looking at a top view) as it is constrained to stay parallel to the floor. 

Snapping Options

From the Palettes menu, select the Cursor Options palette. Set up the dialog as below t
close the palette:
2-25
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Snapping is the alignment of points with other points. When positioning object snapping
will display (and sounds may play) when the snapping points of the selected objects are
aligned or snapped to the snapping points of the unselected objects. 

Add a Bedside Table

Using the Find tool in the library palette, search for White/Pine Bedside. As previously 
described, insert the object into the same room as the bed. Similarly as the bed we nee
rotate the bedside table 90° clockwise. Position the bedside table at the bottom right ed
the bed:

Duplicating Objects

Having the bedside table selected, we can use the Duplicate tool from the Edit Menu.
2-26
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You will notice the new duplicate object will become selected. Using the arrow tool we c
position the bedside table on the opposite side of the bed. You will notice the alignment 
will display to indicate it is aligned with the original bedside chest.
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Add the Remaining Furniture

Use methods described above, changing the view turning snapping on and off as neces
add the following furniture and accessories to the room. 

Note: that most items have an orientation assigned to them, so they will be placed in the
the correct way up. Objects will also snap to the surface they are dropped on, so ensure
mouse button is over the correct object before releasing. Resize items as required

• Add a TV & Video Unit on the wall opposite the bed. (Living Room 
library)

• Place the Waiting Room Table next to the patio door. (Tables library)

• Put two Comfortable Chairs facing the patio door. (Chairs library)

• Add the White/Pine Wardrobe and the White/Pine Small Wardrobe on the 
opposite wall of the patio door. (Bedroom Library)

• Insert a Corner Shower Round in the top right corner of the bathroom. 
(Bathroom library)
2-28



• Add an Aqua Sink Large and position it on the wall opposite the bathroom 
window. (Bathroom library)

• On the same wall as the window, add an Aqua Toilet. (Bathroom library)

• On the wall opposite to the bathroom door, add an Aqua Wall Storage. 
(Bathroom Library)

• And finally place a Mirror Square on the wall above the sink. (Bathroom 
library)
2-29
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Select Bedroom View from the View menu to look at the bedroom from within the room:

Note: You may need to reposition the camera, with the NaviCam, if the newly fitted ward
is obstructing the view.

Save the file.

υ Lighting

Wall Lights

Use the NaviCam palette to change the view so that you are looking at the right wall and
see the chest drawers on either side of the bed (you may need to click on the Zoom but
the NaviCam palette and drag down to zoom out):
2-30
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From the Lights library, drag and drop the Square Wall Light on to the wall above each be
chest.

Position the lights so that they are both at the same height from the floor using either the
ping tool or adjusting the height (Y position value: 1600 mm) for each light in the Info pa
2-31
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Sun Light

Select the Sun Direction tool in the Tools Palette:

The Lights palette is displayed and the document view changes to a top view:

A red line with a handle at the end of it shows the current sun direction. Click on the han
and drag to adjust the direction of the sunlight:

Lights Palette

You can bring up the Lights palette from the Palettes menu. Experiment with the control
see how they affect the scene.

Save the document.
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υ Colors and Textures

Colors and textures can easily be applied to objects within your room. In this example w
use those provided in the libraries included, but as any picture image can be applied as 
ture, you can scan actual paper and fabric samples to use in your interior design.

Add Colors

1. Return to the Bedroom view, open the libraries palette if necessary by selecting it
name in the Palette menu.

2. Chose colors from the Display menu to open the Colors library.

3. Click on a suitable color and, holding down the mouse button, drag the cursor ove
to a wall. When the mouse is over the wall, release the mouse button to drop the 
onto it. 

Note: Since the interior L shaped walls were made separate to the first walls we drew; y
need to apply the color to both wall sections.

Add Textures

1. Open the Textures Large library.
2-33
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2. In this case we will carpet the flooring. Find Carpet 3 in the library and drag and d
the texture on to the floor as you did with the wall coloring.

Adjusting Textures

As the texture applied to the floor is much too large, we will adjust it using the Textures pa
This opens automatically when a texture is dragged and dropped onto an object, but can
opened by selecting its name n the Palettes menu.

1. Select the floor. Its texture is displayed in the Textures palette:

2. Ensure that the Constrain Horizontal and Vertical Scale checkbox is checked on.

3. Click and drag on either the Horizontal Scale or Vertical Scale scrollbar to increas
texture scale to about 9, or enter 9 in the Horizontal Scale or Vertical Scale field.
2-34
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Note: Hold down the Shift key while dragging on the scroll bar to adjust the scale by who
numbers.

4. The texture on the floor is scaled accordingly:

Manipulating Existing Objects

Sometimes you may wish to apply color or texture to just part of an object rather than th
whole object. Depending on how the object is constructed, it is usually possible to add co
texture to individual surfaces.

1. Select the Comfortable Chair

2. Select Dismantleable from the Options menu. This allows the object to be broken 
into its component parts.
2-35
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3. Select Edit Group from the Options menu. An editing window opens showing only
chair. You will notice in this case the chair has been divided into the Seat and the 

4. Select the chair and choose the Look At Selected from the View menu. This posit
the camera so that the chair is in the centre of the view.

5. You can change the camera view of the chair if necessary to gain a better view:

6. Deselect the chair by clicking on the grid and select the seat.

7. You can now drag and drop any texture or color on to the seat.

8. Click on the top left corner of the editing window to close it. The chair remains in i
original position within the room, but now displays the new texture/color applied. 

Save the document.

υ Add a Ceiling

As we have now finished our interior design we can add a ceiling to the room.

1. Click on any of the external walls that were drawn first.
2-36



2. Choose Ceilings from the Plug-in menu:

3. A ceiling is added to the room:

Save the document.
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υ Adjust Lighting

Open the Lights palette if necessary by selecting its name in the Palettes menu.

Adjust the brightness of Spot/Point lights, Ambient light and Sun light, or turn lights off an
to see the effect on your scene.

Set the lighting levels to give the effect you desire for your final render.

To see the effect of lighting on the final render we have included the Microspot Preview 
derer within the Renderer Options palette

1. Open the Renderer Options palette by selecting its name in the palette menu.

2. Select Microspot Preview Renderer from the Renderer pop-up menu.

3. The scene will now be rendered in preview quality.

4. Experiment with the light setting until you reach the desired lighting effect.

υ Look Around

Select Interactive in the renderers pop up in the Renderer Options palette, select the VR
the Tools palette:

When the VR plug-in is selected, the NaviCam is automatically opened so that you can 
use it to make changes to the camera position and view.
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Select the Bedroom View from the View menu then click in the document window, hold d
the mouse button and drag to look around the room using the following controls:

• To pan the camera (turn it left and right): drag the moue button left and 
right.

• To tilt the camera: drag the mouse up and down. The tilt is limited +/- 90°.

• To crab the camera (move it to the left or right): hold own the Command 
key and drag the mouse left and right.

• To move the camera forwards and backwards: hold down the Command 
key and drag the mouse up and down.

• To zoom in: hold down the Shift key

• To zoom out: hold down the Control key

As you move, the cursor changes to an arrowhead pointing in the direction you are mov
all cases, the further you move the mouse from the point first clicked on, the fast the cam
will move. Hold down the Option key will decrease the speed at which the camera move

Using the VR tool, Orbit tool, Walkthrough tool or NaviCam palette to set the view for yo
final render.

Save the document.

υ Final Render

Now that your room is complete and we have chosen a specific view we can produce a 
quality render.

1. Open the Render Options palette by selecting its name in the Palettes menu
2-39
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2. Hold down the Option key and select Microspot Renderer from the Renderer popu
menu:

3. A dialog displays options available for the Microspot Renderer. Click OK

4. The scene will be rendered at a higher quality. Status information displays in the H
palette.

5. Experiment with the lighting controls in the Lights palette and the Renderer Option
see how they affect the quality and realism of the render produced.
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Note: Always reselect the Interactive Renderer in the Renderer pop-up menu in the Ren
Options palette before making any changes to your scene or view.

υ Export Picture or Print

Now that the final render has been produced we can export a picture and/or print the wi
view.

Export Image

The Picture plug-in provides several format options for saving you documents view.
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1. Select Picture from the Export submenu. The Save Picture Options dialog display

2. Choose the desired pixel depth from the Pixel popup menu

3. Enter a value in dots per inch to specify the resolution at which the picture is to be
saved

4. Select Dots, Millimeters or Inches from the Units popup menus (constraining the p
portions of the image by checking the check box if necessary), and then enter valu
the width and height required.

5. Click on the Resize to Window button to change the resolution back to 72dpi and 
width and height of the contents of the document window.

Click OK to accept the options as set. Enter a name and select a location to save the file
standard Save dialog that display and click Save.

Then a small dialog will show displaying the current progress of the render to file. You m
cancel this at any time by clicking on the cancel button

Note: When saving as TIFF output, set the TIFF Options to Millions of Colors or less
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Print

To print the document view, select Print from the File menu:

υ Animation

We will now create a fly through animation of the room, and eventually export the animati
a QuickTime movie.

Drawing a Path

By clicking on the Animation Draw Path tool from the Tools palette, the view will automa
cally shift to a Plan view:

With the first mouse click we will determine the starting position of the path the camera. I
case the camera will start at the front door then turn right into the room and after going r
the bedroom. The movie then ends in the bathroom:
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To end the path, double click with the mouse on the final position. Once you have finishe
drawing the path, the view will automatically change to the Bedroom View.  

Note: The path tool will automatically be drawn at eye-level height to simulate a walk thro
effect. This height may be adjusted by option clicking on the Animation Draw Path tool a
adjusting the height in the Animation Path Options palette that appears. 

Editing a Path

To edit any part of the path you have just drawn, select the Animation Edit Path tool from
Tools menu:

You will notice a new palette will appear to help you amend certain aspects of the path. 
Change the viewing field to Plan View. Select the path you’ve just created, you can now u
options on the palette to edit this path. 
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To create curved corners for the camera to follow we can select a point on the path and 
Spline. 
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Once the point has been converted to an arc, you can drag the individual point and crea
ferent curves to fit in the room better:

Setting Animation Time and Camera

Deselect the path once you have finishing editing it by selecting the arrow tool from the 
menu. Open the following palettes from the Palette menu.

Animation Path palette:

Note: To fully open all the options on this palette, you need to click on the green button t
maximize the palette.
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Animation Player palette:

Note: To fully open all the options on this palette, you need to click on the green button t
maximize the palette.

Animation Tweener palette:

On the Tweener palette you will see a time line signified by starting and ending arrowhe
Open the Animation Tweener wider by clicking and dragging on the bottom right hand co
until 20 seconds shows in the timeline. Click and drag the End arrowhead to the 20 seco
time mark. This has set the animation time to run for 20 seconds:
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We must now set the path time on the Animation Path palette to 20 seconds to fit the tim
frame. Click the Reset button:

In the same palette, click on the Animate pop up menu to select View Point. This will ani
the camera viewpoint to run on the path you have created. Once View Point option is se
click on the top right tab labelled +Camera button:

Adjusting Camera Viewpoint

Now that the camera has been assigned to the animation path, you can click on the play
in the Animation Tweener or Animation Player palette. You will notice the camera positio
be too far out to obtain an inside view of the bedroom. Adjust the camera position on the
NaviCam to be closer to the viewpoint:
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You can also zoom in and out on the NaviCam palette to adjust the view.

Note: Distortion may occur when using the zoom tool.

Exporting a Movie

Once you are satisfied with the animation path and camera view, you can export the ani
as a QuickTime movie. The movie will be exported with the current Render Options sett
For higher quality graphics use the Microspot Renderer. The higher the Microspot Rend
settings are set the longer the movie will take to export, in this case we will export it in 
Microspot Preview Renderer.

You can now select Microspot Preview Renderer in the Renderer palette pop-up menu:
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As the bedroom scene begins to render, select Export Movie from the Animation menu:

A new window will open for you to allocate where you want the file to be saved, Once yo
have saved the file, a status window will open to inform you on the expected time remain
export the movie:

υ Summary

This tutorial should have given you a good idea of the capabilities of Interiors and explai
how to use many of the features. Please refer to the reference part of the manual to exp
many more advanced features available.
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Chapter 3

Menus

Details of the application’s File, Edit, View, Options, Palettes, Plug-in, Ani-
mation and Help menus. Command key shortcuts can be used to perform
many menu commands. See Appendix L — Command Key Table on page L-1
for details.
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 INTERIORS MENU

Click on the word Interiors at the top left of the screen to display the Interiors menu. The
three items relate to Interiors:

υ About Interiors 

Select About Interiors to display the About Interiors dialog. This provides information abo
the version of the application you are running, registration and serial number details.
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υ About Plug-ins

Select About Plug-ins and hold down the mouse button to display the list of the plug-ins
are currently running:
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Select a plug-in name from the list to display a dialog containing brief details about the p
in.

υ Preferences

Select Preferences to display the Preferences dialog:
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Colors

To change color preferences, click on a color square to display the Color Picker. Select 
color and close the Color Picker.

• Handle Color: The color of the handles on the bounding frame of a selected object.

• Open Handle Color: The color of the handles on the bounding frame of a group of obje
when an Editing or Group window is open, and the color of the active handle when a
object is being resized.

• Locked Handle Color: The color of the handles on the bounding frame of a locked obje

• Light Marker Color: The color of the cone or point marking the position of a Spot/Point
Light. If this color is set to white, the color of each light marker will be the same as t
color of the light.

• Grid Color: The color of the grid.

• Background Color: The color displayed in the background of a new file.

• Default Color: This is the color that displays in the color block in the window toolbar an
used to draw new objects.

• World X, Y, Z Color: The colors that are used to draw the respective axis.

• Object X,Y,Z Color: The colors that are used to draw the lines of the bounding frame o
object.

Default Tool

Choose either the Arrow or Rotate Tool as the default tool.

Options

• High Resolution Printing: Click to print at printer resolution rather than screen resolutio

• Sound On: Click to play sounds within the application.

• Dynamic Updates: If this option is enabled, all open windows for a particular documen
will automatically be updated as objects are created or manipulated in the active win
and as slider bar controls in palettes are changed. If this option is not enabled, only
active window will be updated as actions are performed. Other open windows will no
updated until the action is complete and when moving slider controls, views will not 
updated until the mouse is released.
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• Solid Grid: Click to specify that the document grid should appear as a solid floor rath
than a wire frame grid.

• Global Lights: When this check box is enabled, the controls in the Lights palette relate
the document. When it is not enabled, the controls in the Lights palette relate to the 
window only.

• Advanced Handles: When this option is checked on, the lines of the bounding frame of
object can be clicked on and dragged to resize the object.

• Auto Show Plug-in Palettes: When this option is checked on, whenever a plug-in tool is 
selected in the Tools palette, any plug-in palettes that are associated are opened.

• Auto Hide Plug-in Palettes: When this option is checked on, whenever a plug-in tool is 
selected in the Tools palette, any plug-in palettes currently open are closed. This he
prevent your work space from becoming too cluttered.

• Do Undos: The Do Undos checkbox is used to specify whether or not you wish to be 
to use the Undo command. It is checked on by default.

• Display X, Y, Z World Axis: These options enable the display of the world axis that are 
drawn with the origin in the center of the grid.

• Edges to a Circle: Enter a value for the number of sides a circle should have. This will af
the appearance of circles, spheres, cylinders, etc. The lower the value, the coarser 
curve. The higher the value, the more memory and disk space you will need to displa
store the images. The default value is 24.

Note: In version 3.6 Dynamic Tesselation has been added so that objects viewed in the 
ground will have the full number of edges but items in the background will have progress
less. This enables faster rendering of objects as they become less obvious in the scene

υ Quit

Quits the application and closes all open files and their associated windows. If any open
have been changed without being saved, a dialog will display asking if you wish to save
changes.
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FILE MENU

υ New

Creates a new, untitled document.

If there is a document called Default Stationery Pad located in the same folder as the ap
tion, a copy of this document will be opened as an untitled document (a document is tag
a stationery pad via the Get Info dialog). This allows you to use the same customized se
for each document.

υ Open

Opens an existing Interiors file, or any other file created by a 3DMF-compatible applicat
(Such as Microspot  Modeler).
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υ Insert

Select Insert to input 3DMF or picture files into the documents.

When the standard dialog displays, select a file to insert. The Insert Dialog will display:

The options available will depend upon the type of file selected, and whether an object w
selected when Insert was chosen. The type of file selected will be indicated on the right s
the dialog.

Add as Object

The selected file appears either in the center of the grid or at the last place the mouse w
clicked.

• 3DMF file: Appears as a 3D object, the orientation of which will depend on the informa
contained in the 3DMF file.
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• Picture file: The image displays as a rectangle with the same proportions as the origin
picture. The longest side of the rectangle is equivalent to the length of one side of on
square and its orientation relates to the grid.

Add to Object

This option is only available if an object was selected in the document before Insert was
sen. The file is converted to a picture (if necessary) and applied to the selected object a
ture. The properties of the selected object will determine how it is applied.

Fore/Background Picture

The file is converted to a picture (if necessary) and placed in the foreground/background
it remains even if the view changes. If the proportions of the image are not the same as t
portions of the window, the image is distorted to fit the window. Its size remains constan
tive to the window size.
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υ Import

The Import submenu allows you to access Import options. See Appendix A — Appendix A on
page A-1 for more details.

υ Export

The Export submenu allows you to access Export options. See Appendix B — Appendix B on
page B-1 for more details.

υ Close

Closes the current document and its associated windows. If the document has not been
or if changes have been made to it since it was last saved, an alert will display asking if 
want to save the document before closing.
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υ Save

The Save option is only available if a document has never been saved, or if changes hav
made to it since it was last saved. Using the Save option saves the document in 3D meta
mat. If the document has not been saved before, a dialog will display for you to specify t
document name and a location to save it.

To save a document as a stationery pad, give it the name Default Stationery Pad. The do
will be automatically tagged as a stationery pad. 

υ Save As

Choose to save a document (in 3D metafile format) under a different name or in a differe
location. If you try to save a document in the same location as a document of the same 
an alert will ask if you wish to replace the existing file.

υ Revert

Returns to the last saved version of a document. (This option will only be available if the
ument has been previously saved.) An alert will display to ask if you are sure you wish to
revert.

υ Page Setup

Select to display the Page Setup dialog. The options available in the Page Setup dialog
depend on the printer driver you have selected in the Printer Setup Utility.
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υ Print

Select to display the Print dialog. The options available in the Print dialog will depend on
printer driver you have selected in the Printer Setup Utility.

EDIT MENU

υ Undo

Allows you to undo your last object manipulation. Selections, de-selections, mode chang
and view changes are not object manipulations, and therefore cannot be undone.
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This option will be disabled if no document is open, if an open document has not been ch
since it was last saved, or if Do Undos has been turned off in the Preferences dialog. See 
Options on page 3-6 for further details.

After an object manipulation has been undone, the Undo option will change to Redo. Se
Redo to perform the action again.

υ Cut

Removes a selected item from the current document and places it on the clipboard whe
remains until replaced by another item cut or copied from the document.

υ Copy

Copies a selected item from the current document and places it on the clipboard where 
remains until replaced by another item cut or copied from the document.

υ Paste

Pastes items into the current file either in the center of the grid or at the last place the m
was clicked. 3DMF or PIC files can be pasted into Interiors documents. 3DMF data are p
in as 3D objects and PICT files are pasted in as rectangles.
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υ Paste Special

Paste Special is only available if you have cut or copied items from an application other 
Interiors. When you select Paste Special, the following dialog displays:

Items cut or copied from other applications can be placed in  Interiors documents in a va
of ways, depending on their formats. 

The Paste Special options available to you will depend on the type of file selected, and w
an object was selected prior to choosing Paste Special.

Add as Object

The file will appear either in the center of the grid or at the last place the mouse was clic

• 3D Object: Appears as a 3DMF, the orientation of which depends on the information c
tained in the 3D object file.
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• Picture: The image displays as a rectangle with the same proportions as the original 
ture. The longest side of the rectangle is equivalent to the length of one side of one 
square, and its orientation relates to the grid.

Add to Object

This option is only available if an object was selected in the document prior to choosing 
Special.

Available for:

• 3D object: The file is converted to a picture and applied to the selected object as a tex
The properties of the selected object will determine how it is applied.

• Picture: The file is applied to the selected object as a texture. The properties of the se
object will determine how it is applied.

Fore/Background Picture

The file is converted to a picture (if necessary) and displayed in the document foregroun
background where it remains even if the view changes. If the proportions of the image a
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the same as the proportions of the window, the image is distorted to fit the window. Its s
remains constant, relative to the window size.

Available for:

• 3D object

• Picture

υ Delete

Use the Delete command to remove items or attributes. The six options in the top part o
popup menu are only available if an item is selected within the document before Delete 
sen.
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 An entire object can also be deleted from a file by dragging and dropping it into the tras

The last three options in the Delete menu allow you to remove the document’s backgrou
color, background picture and foreground picture.

υ Select All

Selects all of the objects in the current window.

υ Select None

Deselects all of the selected items in the current window.

υ Duplicate and Clone

The Duplicate and Clone operations appear identical, however, when an object is duplic
the duplicate is created as an entirely separate item and is unrelated to the original. Wh
object is cloned, the clones share the same basic geometry and surface attributes as th
nal. This means that if the geometry, color, transparency etc. of the original is changed, 
clones will also be changed, and if a clone is changed, other clones and the original will
changed. The link relates to the basic geometry and surface attributes only. Changes in
position and rotation will not be reflected by the clones.

The Clone command can be very useful in certain situations as due to their shared attrib
clones use less memory than duplicates, and changes can be made quickly to several c
objects at once.
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1. Select an item or group of items and choose Duplicate/Clone.

2. A duplicate/clone of the selected item or group of items is placed one grid square 
right of the original:

3. Move the duplicate/clone and choose Duplicate/Clone again.
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4. The second duplicate/clone will be positioned in the same position relative to the 
duplicate/clone, as the first duplicate/clone was to the original:

Any rotations that are applied after the first duplication are also applied to subsequent d
cated items. This is useful for drawing items like spiral staircases.

Hold down the Shift key when using the Duplicate/Clone option to avoid applying any of
3-20
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υ Group

Groups two or more objects and allows them to be manipulated as a single object.

1. Select the desired items, then choose Group. Grouped items will be surrounded b
bounding rectangle or sphere depending on whether the arrow or rotate tool was u
select them:

2. Double-click on the group or choose Edit Group from the Options menu to open a
window containing only the items within the group:
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3. Manipulate these items individually, then close the window to view your changes in
original document:

While a Group window is open, the handles of the bounding rectangle or sphere around
original grouped items will change color. This indicates that the objects are selected, an
Group window is open. The color of the handles is set in the Preferences dialog. See Colors on 
page 3-6 for further details.

If the grouped objects have been placed in further groups, the Group window will contai
grouped objects. Double-clicking on these groups will open additional windows showing
contents of their respective groups.

If a group of objects is flagged as Primitive, it is not possible to edit the items within the g
by double-clicking on the group or choosing Edit Item from the Options menu. The grou
must be flagged as Dismantleable before the individual items can be edited. 

υ Ungroup

Un-groups selected items so that members of a group can be selected individually. Note
this option only un-groups one level at a time.

If a group is flagged as Primitive, the Ungroup option will be grayed out in the Edit menu
will not be selectable. The group must be flagged as Dismantleable before it can be un-
grouped.
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VIEW MENU

υ New Window

Opens a new window for the current document. The new window displays the same view
the original window, and is offset from it. 

υ Close Window

Closes the current window. If this is the last open window for a document, the document
also be closed. 
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υ Name View

Saves the current view. Enter a name for the view in the dialog that displays:

You cannot use the names of the standard views included in the program. If you specify a
that has already been used to save a nonstandard view, an alert displays asking if you w
name your view.

υ Delete View

Deletes a saved view. This option is only available when new views have been created a
saved (standard program views cannot be deleted).

1. Select Delete View and a submenu lists the views that may be deleted:

2. Select the name of the view to delete from the submenu and the view will be dele

3. If you do not select a view from the submenu, the delete view dialog displays sho
the views that can be deleted

4. Select the view to delete and click OK.
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Note: If a document window was displaying a view that has now been deleted, the window
remain open as an untitled view.

υ Change View

Click on Change View to display a popup menu which lists the available views (including
that you have saved). The view in the current window will be indicated by a check mark. M
the cursor down the list to select the desired view:

The current window will change to reflect your choice. If a standard view has been chan
hold down the Option key and select the name of the standard view to reset it to the def
standard view.

The view displayed can also be changed via the Command key shortcuts shown in the C
View popup menu above, or through the popup menu in the Window controls. See View on 
page 4-30 for further details..
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Look at Selected

Displays a selected object in the center of the window:

Home View

Returns the camera to its initial position (the view displayed when a new file is opened):

Custom

Any nonstandard view, or any view that has not been saved is a Custom view.
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Plan, Top, Front, Left, Right and Back

The six standard views that allow you to display the file from the sides, top and a plan vi

Last View

The view that was displayed in the window immediately prior to the current view.

υ Open Documents

At the bottom of the view menu is a list of the documents and views that are currently op
The active window has a check mark to the left of its name. Documents that have been ch
since they were saved are underlined. Select a document/window name from the list to m
the active window:

Plan

Top

Left Right

Front Back
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OPTIONS MENU

υ Edit Group

Select to edit individual objects within a group.
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Double-click on the group, or select the group and choose Edit Group from the Options m
to display a new window which contains only the items in the group.

The items can now be edited individually. As you edit the individual items, the group rem
locked in the original file window, although it will be updated to reflect any changes you m

Hold down the Option key when closing an editing window, and all editing windows for th
file will be closed.

Items and groups can be flagged as Primitive or Dismantleable. If the selected group ha
flagged as Primitive, Edit Group will be grayed out and will not be selectable. Flag the g
as Dismantleable to edit it. 
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υ Lock

Protects a selected object or group from being changed. A locked object can be groupe
other objects, but cannot be moved, resized or changed. If you group a locked object with
objects, the entire group will be locked.

If you place the cursor over a locked object, a padlock displays next to it.

An object or group can also be locked by selecting it and clicking on the large open pad
icon in the top right corner of the Info Palette. See Lock on page 4-18 for further details. 

υ Unlock

Select a locked object or group and choose Unlock to remove the protection against cha
An object or group can also be unlocked by selecting it and clicking on the large closed 
lock icon in the top right corner of the Info Palette. See Lock on page 4-18 for further details

υ Primitive

Specifies that an item or group should be treated as a basic geometry. A basic geometry
be un-grouped, so individual surfaces or items cannot be edited. 

υ Dismantleable

Specify that an item or group can be broken down into its component parts. This will allow
to ungroup an item or items and edit individual components as separate items. 
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υ Grid Snap

Grid Snap applies an invisible grid to the document to which object points can snap. It is
enabled by default to make it easier to align objects. The distances between the nodes 
grid are determined by the value entered for the Snapping Grid Distance in the Grid Opt
dialog.

When Grid Snap is enabled and a new item is drawn, the cursor is positioned on the clo
snapping grid intersection. As the object is drawn, the object’s handles snap to the snap
grid’s intersection points. As an object is resized, the object’s handles are positioned on 
ping grid intersection points. When an item is moved, its center point will snap to the sna
grid intersection points.

If Grid Snap was disabled when an object was randomly positioned in the file, the item w
moved or resized in increments of the snapping grid distance when Grid Snap is enable

Reselect the Grid Snap option in the Options menu to turn this option off.

υ Grid Options

Choose Grid Options to display the Grid Options dialog:
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• Solid grid: When this check box is enabled the documents grid will appear as a solid 
rather than a wire frame.

• Number of grid squares: This value relates to the visible grid. Enter a value to specify th
number of grid squares that should make up one side of the grid.

• Grid square size: This value relates to the visible grid. Enter a value to specify the lengt
one side of one grid square.

• Snapping grid distance: This value defines the invisible snapping grid. Enter a value for
length of one side of one snapping grid square. Typically, you will want to give the s
ping grid distance a value that is a fraction or multiple of one document grid square.

• Preferred unit size: This option allows you to select a unit size.

The entries in the popup menu are determined by whether metric or inches has bee
selected in the Options menu as discussed below.

υ Metric

Select this option to use metric units of measurement. The grid size, position coordinate
dimensions will all be calculated using metric units. 

υ Inches 

Select this option to use inches, feet or yards as the units of measurement. The grid siz
tion coordinates and dimensions will all be calculated using inches, feet or yards.
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υ Window Size

Set the size of the current drawing window in screen dimensions.

Note: Pixels are a measure of dot on screen, with a pixel representing a single dot.  

υ Orbit Around View

Select Orbit Around View to rotate the camera around the point at the center of the curre
view. Click anywhere in the window to stop the rotation.
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PALETTES MENU

Click on Palettes in the application menu bar to display a list of available palettes.  Selec
palette name from the list to open it.

When a palette is currently open, a tick will appear next to it in the palette menu. If it has
docked with another tab, but is currently not visible, a diamond will appear next to it in th
menu.

See Chapter 4 — Tools Palette on page 4-4 for details of the Tools, Info and Help palette
Appendix D — Plug-in Palettes on page D-1 for details of plug-in palettes.
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PLUG-IN MENU

Click on Plug-ins in the application menu bar to display a list of available plug-ins. 

Select the plug-in name from the list to open it.

See Appendix C — for details of the plug-ins accessed from the Plug-ins menu.

ANIMATION MENU

Click on Animation in the application menu bar to display a list of animation plug-ins.

Select the animation plug-in name from the list to open it.

See Appendix C — for details of the plug-ins accessed from the Plug-ins menu.
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υ Interiors Manual

Select this option to launch and display the Microspot Interiors User Guide.

υ Microspot Library Download

Select Microspot Library Download to go to the Microspot Download web page to downl
the latest libraries and updates.

υ Registration Information

Select Registration Information to register your product via the Microspot web page. The
ister Information dialog displays:

Click on the Connect button in the dialog to go to the web page.
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υ Upgrade Information

Select Upgrade Information to obtain product upgrade information (if any) from the Micro
web page. The Upgrade Information dialog displays:

Click on the Connect button in the dialog to go to the web page or alternatively, contact 
Microspot via telephone, fax or email for upgrade information.
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Chapter 4

Palettes

The Tools, Info and Help palettes are the standard palettes included in the
application. All other palettes are plug-in palettes that are loaded when the
application is launched. 
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INTRODUCTION

To open a palette, select its name from the Palettes menu. The Palettes menu lists of al
available palettes.

The status and position of palettes is remembered each time the application is closed. C
palette by clicking on the top left corner of the palette window.
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Tools Palette

The tools built-in to the application Tools palette are the Arrow, Rotate, Rectangular Mar
and Hand tools.

The rest of the tools are plug-ins that are loaded when the application is launched 

Select the tool to use by clicking on its icon in the Tools palette. After a tool has been use
currently selected tool reverts to being the Arrow tool, unless the default tool is changed 
Preferences dialog. See Preferences on page 3-5 for further details. You can, however, double-
click on any tool to lock it in so that it will not change after you use it, but will remain sele

υ Select/Move

Both the Arrow and Rotation tools can be used for selecting and moving objects. You ca
click and drag on the grid with either tool to move the entire scene in the window. 

Note: Objects may be locked to prevent them being moved or rotated in one or more direc
or to prevent them being resized. 

Select

When an object is selected, it is surrounded by a bounding frame with handles at the po
where the bounding lines intersect:

Arrow (a)

Rectangular Marquee (m)

Rotate (r)

Hand (h)
4-4



he 
t dis-

. To 
 click 
ame 

n be 
To temporarily hide an object’s bounding frame, hold down the Option key and click on t
arrow or rotate tool. The item is still selected, but the bounding frame and handles do no
play. To re-display, click on the arrow or rotate tool again.

To add objects to a selection, hold down the Shift key and click on the additional objects
deselect one object in a selection, hold down the Shift key and click on the object. If you
on an object that is part of a group, the entire group will be selected and the bounding fr
will surround all of the items in the group. 

Double-click on a group of objects to open a new window in which the grouped items ca
edited:
4-5
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When you close this editing window, any changes you have made will be reflected in the
nal document window. You can also edit a group by selecting it and choosing Edit Item f
the Options menu. See Edit Group on page 3-28 for further details.

Hold down the Command key and click the mouse to select an object that is behind ano
object. Initially, the foremost object will be selected. The second time you click the mouse
next object back will be selected, and so on:

Move

To move an object, click on it, hold down the mouse button, and drag. Release the mous
ton to place the object in its new location. Hold down the Control key and drag up or dow
move the object closer or further away. If you hold down the Shift key, lines will display s
ing the X, Y and Z axes, and movement will be constrained to these axes:
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Objects can also be moved by entering coordinate values in the Info Palette. 

υ Select/Move/Scale

Note: Objects may be locked to prevent them being moved or rotated in one or more direc
or to prevent them being resized.

Select an object with the Arrow tool, it will display surrounded by a bounding frame with 
dles at the corners.

As an alternative to clicking and dragging, you can move an object using the arrow keys
selecting the object and pressing the desired arrow key to move it one pixel. If you hold 
the arrow key, the object will move one pixel at a time until it has moved six pixels. It will t
begin to move at an accelerated rate. To move objects closer or further away, hold down
Control key while using the up and down arrow keys.
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To change the size of an object, move the cursor over one of the handles of the boundin
frame. When the cursor changes to a white arrow, click the mouse and drag. The shape
of the object will change to reflect your actions:

Note: If the Advanced Handles preference is checked on in the Preferences dialog, the li
the bounding frame of an object can also be clicked on and dragged to resize the object

Hold down the Shift key when resizing an object to constrain movement to the X, Y, or Z
or to maintain the objects proportions. Four constraining lines are displayed. The red lin
resents the X-axis; the green line the Y-axis; and the blue line the Z-axis. The pink line re
sents the line along which the object will retain its current proportions: 
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If, after resizing the object, you hold down the Option and Shift keys and resize the obje
second time, the pink line will move to a position which allows you to constrain the objec
the proportions it was originally drawn with:

Objects can also be resized via the controls in the Info Palette. 

υ Select/Move/Rotate

Note: Objects may be locked to prevent them being moved or rotated in one or more direc
or to prevent them being resized. 

When an object is selected with the Rotate tool, it displays surrounded by a bounding sp
with six handles.

To rotate the object, move the cursor over one of the widgets of the bounding frame. Wh
cursor changes to a white arrow, click the mouse and drag. The object will rotate to reflec
actions:
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Note: holding down the Shift key while rotating an object using the handles, constrains th
rotation to 90°.

To rotate the object, in one axis only, move the cursor over one of the lines of the bound
frame. When the cursor changes to a white arrow, pointing right, click the mouse and dra
object will rotate to reflect your actions in one axis only:

Note: holding down the Shift key while rotating an object using the rotation rings, constra
the rotation to 45°.

You can also use the arrow keys to rotate objects. If you hold down the arrow key, the ob
will rotate in 1° increments for 6°, then accelerate to 10° steps. If you hold down the Shif
4-10
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while using the arrow keys, you can rotate objects in 45° increments. To tilt an object, ho
down the Control key and use the left and right arrow keys.

The arrow keys can also be used to move and rotate the camera when nothing is selecte
document window. The camera will either move or rotate depending on which tool is curr
selected. Use the control key to move the camera in the Z dimension.

υ Manipulating The Grid

The Arrow and Rotate tools can be used to move and rotate the grid, as well as objects,
ily manipulate your view of a document.

Moving The Grid

Select the Arrow tool and move the cursor over the grid. Hold down the mouse button, th
sor changes to an open hand. Move the cursor up, down, left or right. The grid will move
reflect your actions:
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Hold down the Control key and move the mouse up and down to move the grid closer an
ther away:

Hold down the Shift key when moving the grid to display, and constrain movement to, the
and Z axes:

Additionally, you can hold down the command key to rotate the grid, whilst the arrow too
selected.
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Rotating The Grid

Select the Rotate tool and move the cursor over the grid. Hold down the mouse button, t
sor changes to an open hand. Move the mouse up, down, left or right. The grid moves to
your actions:

Hold down the Shift key while rotating the grid to constrain it to its initial plane. It can the
only be rotated in that plane:

Holding the command key down before grabbing the grid will allow you to switch betwee
rotating or moving the grid.
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υ Rectangular Marquee 

Select the Rectangular Marquee tool, hold down the mouse and drag out a rectangle to 
one or several objects. (Note that if any part of an object is inside the marquee, that obje
also be selected.)

To add objects to a selection, hold down the Shift key and drag a rectangle around the d
objects. To deselect items, hold down the Shift key and drag a rectangle around selected
You can also add or remove items from a selection by clicking on them with a Selection 
while holding down the Shift key.

υ Hand

Use the Hand tool to change the view of the document by altering the position of the cam
When you select the Hand tool, a frame will appear around the contents of the window. 
curser will change type near the corners of the frame:
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You can either position the view within the frame, or position the frame around the view. 
position the view, click outside the frame and drag the mouse. To position the frame, clic
inside the frame and drag the mouse:

If you are in an elevation or orthogonal view, move the mouse left and right to crab, or up
down to change the camera height.

If you are in a perspective or user defined view, move the mouse left and right to pan the
era, or up and down to tilt the camera. Hold down the Option key and move left and righ
crab, up and down to change the height.
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To zoom in on an object (note that you are not actually moving the camera, but rather na
ing the focus), click on one of the frame corners and drag it in towards the center of the 
dow:

When you select another tool, the window changes to show the view you have chosen:
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INFO PALETTE

The Info palette displays information about, and provides controls for you to adjust, the c
acteristics of a selected object or light.

Select Info from the Palettes menu to display the Info Palette. When it is first opened, all 
Info palette will be visible. To reduce the palette click on the button on the right in the top
corner of the palette. To extend the window, click again.

Note: The controls in the Info Palette will vary depending on whether you have selected a
object or a spot/point light in the document window:

υ Name

The Name box provides a space to enter a name for an object or group of objects. Thi
will be displayed whenever the object or group is selected.

 Lock Position

Lock Size

Lock Rotation

Constrain

Lock Object
Primitive/

Lock Reflective Color

Dismantleable Flag

Proportions

Lock Surface Color
4-17
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υ Primitive/Dismantleable

This option is only available when an item or group is selected. A Primitive item cannot b
ungrouped into component items. Click on the button to toggle between Primitive and Dis
tleable. The solid square button represents the Primitive state and the split button the Di
tleable state. An object can also be specified to be Primitive or Dismantleable by selectin
Primitive or Dismantleable from the Options menu. See Primitive on page 3-30 and Disman-
tleable on page 3-30 for further details.

υ Lock

To lock a selected object or group of objects, click on the padlock icon in the top right c
of the Info palette, or select Lock from the Options menu. See Lock on page 3-30 for furthe
details. This will prevent the object or group from being moved or changed. To unloc
object, click on the Padlock icon a second time, or select Unlock from the Options menSee
Unlock on page 3-30 for further details.

υ Position

The figures displayed in the X,Y and Z Position boxes are the grid coordinates of the cen
the selected object’s bounding rectangle. If you select items that are grouped together, t
coordinates displayed will relate to the group. If you select more than one item and the i
are not grouped, no coordinates will display. 

To precisely position an object, type in values for the X, Y and Z coordinates, then press 
The object will move to reflect your entries.
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Lock Position

The padlocks next to the position boxes are used to lock the position of an object. The lo
options work the same for groups of objects as for single objects.

Click on the padlock next to the X position coordinate. It will close, which means the obje
in a fixed position on the X axis (in relation to the grid), but can still be moved in the Y an
axes. Any or all coordinates can be constrained. If an object’s position is constrained on
three axes, it cannot be moved. However, you can still change the object’s size (unless i
also been constrained).

υ Size

The size boxes display the X,Y and Z dimensions of an object’s bounding rectangle. If y
select items that are grouped together, the dimensions displayed will relate to the group
bounding rectangle. If you select more than one item and the items are not grouped, no 
sions will display. To precisely resize an object, type in values for the X, Y and Z dimens
then press Enter. The object will be resized to reflect your entries.

Note: Information about the object’s size will be grayed out if you have selected a light as
objects have a constant size which cannot be changed.

Lock Size

The padlocks next to the size boxes are used to lock the size of an object. The lock opti
work the same for groups of objects as for single objects.

Click on the padlocks by the size dimensions to constrain an object’s size. Click on a clo
padlock to open it and un-constrain an object’s size. Any or all size dimensions can be c
strained. If all are constrained, the size cannot be changed. If just one dimension is con-
strained, you can change the other dimensions.
4-19
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Constrain Proportions

The Proportional Constrain checkbox to the bottom right of the dimension fields allows y
constrain the proportions of an object. Select an item and click on the checkbox to turn o
portional Constrain.

The item can now be resized or moved, but will always maintain its current proportions.

υ Rotation

Lock Rotation

Below the size controls are additional padlocks for the X, Y, and Z axes that are used to 
strain the rotation of an object.

Click on the padlock relating to the X axis. It will close, indicating that the object cannot 
rotated around the X axis (in relation to the grid), although it can still be rotated in the Y a
axes. The rotation of the object can be constrained in any or all of the axes. The X Y and 
are determined by the orientation of the object.

υ Transparency/Brightness

Transparency

Select an object and use the Transparency slider control to adjust its transparency.
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• When the transparency slider is to the left of the bar, the selected object is opaque:

As the slider is moved along the bar, the object becomes more transparent:
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Brightness

If a light is selected, the first slider control relates to the brightness of the light it emits:

υ Color

Surface

The Surface color box shows the color of the selected object.
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To change the color of the object, click on the Surface color box to display the Color Pic
Select a color and close the dialog. The color you have chosen will be displayed as the S
color and applied to the selected object. 

If a light is selected the Spot Light color box or Point Light color box is the color of the lig
emitted by the light object. The light marker color will also change to this color. If the ligh
marker color was changed by use of the Preferences dialog the light marker will stay the
erence color value. See Colors on page 3-6 for further details. Colors can also be dragged an
dropped onto the spot or point light color box.

Gloss

The Gloss color box shows the reflective color of the selected object. If light is shining o
object (sun light or spot/point lights), the part of the object that shines displays the gloss 
This will only be visible if you have selected the Best Shading option for the interactive r
derer, or the Microspot Renderer via the Renderer Options palette. See Renderer Options on 
page D-31 for more details. This option is not available for lights.

To change the reflective color of the object, click on the Gloss color box to display the C
Picker. Select a color and close the dialog. The color you have chosen will be displayed
Gloss color box. Colors can also be dragged and dropped onto the Gloss color box.

Lock Color

The padlock next to the color boxes is used to protect the color values of an object.
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Matt - Gloss

If an object is selected, the second slider control relates to its amount of gloss or shinine
object has. Use the slider control to adjust the degree of gloss or shine you place on an 
The Matt- Gloss value is affected by the amount of directional light on an object:
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Spread

If a spot light is selected, the second slider control allows you to adjust the lens angle of
light and narrow or widen the beam. Note that this option is not available for point lights:
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Renderer Brightness

If an object is selected, the Renderer Brightness slider control allows you to adjust its refl
ity, which is the amount of ambient light the object reflects. This will only be visible if you
have selected the Microspot Renderer via the Renderer Options palette. See Renderer Options
on page D-31 for more details.:
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Sharpness

If a spot light is selected, the third slider control allows you to adjust the sharpness of the
Move the slider control to sharpen or un-sharpen the focus of the light. Note that this opt
not available for point lights:

υ Comments

The Comments box provides a space to enter details about an object or group of object
as a description). These comments will be displayed whenever the object or group is se
4-27
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THE HELP PALETTE

The Help palette displays coordinate values that show the position of the cursor and hel
sages or information relevant to the tool selected, cursor position or rendering status (if 
interactive renderer is being used).

Select Help from the Palettes menu to display the Help palette:

To resize the Help palette, click on the resize box in the bottom right corner of the palette
holding down the mouse button, drag to resize the palette. Release the mouse button w
palette reaches the desired size.
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WINDOW CONTROLS

The Window controls are displayed at the bottom of each window:

Selecting an option affects only that window, regardless of how many other views are op

υ Zoom Out

Use the Zoom Out button to widen the focus of the camera’s view and make objects app
be farther away. Position the cursor over the Zoom Out icon and click once to zoom out 
slightly. Click and hold the mouse button down to continue zooming out. 

υ Zoom In

Use the Zoom In button to narrow the focus of the camera’s view and make objects app
be closer. Position the cursor over the icon and click once to zoom in slightly. Click and 
the mouse button down to continue zooming in.
4-29



ved. 

-
lly be 

or 
υ View

Use the View popup menu to select a different view, including any view that you have sa
When you select a view option, the window will change to display your selection:

The Command key options and View menu can also be used to choose a view. See Change 
View on page 3-25 for further details.

υ Default Color

The color displayed in the color block at the bottom right of the window toolbar is the cur
rently selected color. Any new items created (except lights and markers) will automatica
this color, even if you are working in wire frame mode.

To change the default color, click on the color block and select a new color from the Col
Picker:
4-30



t will 
n to 
nd 

old 
To change an object’s color, click on the color block and drag the color over the object. I
be highlighted by a bounding frame to show that it is selected. Release the mouse butto
apply the color to the object. You can also select an object, then go to the Color Picker a
select a new color to automatically apply that color.

υ Window Resize

To change the size of the window you are working in, click on the Resize Window icon. H
down the mouse and drag to resize the window.
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Appendix A

Import Plug-ins

Import plug-ins are accessed via the Import submenu in the File menu.
Table of Contents

Introduction A-2

3ds A-2
A-1
Return to main table of contents
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υ Introduction

Open the File menu and select Import. A submenu lists the installed Import options:

υ 3ds 

The 3ds plug-in imports 3ds formatted files into an Interiors document.

1. Select 3ds from the Import submenu in the File menu.

2. Select the file to import from the dialog that displays.

3. The selected file will then be imported into the current Interiors document as a 3D
object.

4. The size of the object will depend on your current grid size.  
A-2
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Appendix B

Export Plug-ins

Export plug-ins are accessed via the Export option in the File menu.
Table of Contents

Introduction B-2

Picture B-2
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υ Introduction

Open the file menu and select Export. A submenu lists the installed Export options:

υ Picture

The Picture plug-in provides several format options for saving your document view.

1. Select Picture from the Export submenu. The Save Picture Options dialog display

2. Choose the desired pixel depth from the Pixel popup menu.

3. Enter a value in dots per inch to specify the resolution at which the picture is to be
saved.

4. Select Dots, Millimeters or Inches from the units popup menus (constraining the p
portions of the image by checking the checkbox if necessary), then enter values f
width and height required.
B-2
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5. Click on the Resize to Window button to change the resolution back to 72 dpi and
width and height to the width and height of the contents of the document window.

Click OK to accept the options as set. Enter a name and select a location to save the file
standard Save dialog that displays and click Save.

Then a small dialog will show, displaying the current progress of the render to file. You m
cancel this at any time by clicking on the cancel button.
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Appendix C

Menu Command Plug-ins

Menu command plug-ins are accessed via the Plug-in menu or Animation
menu.
Table of Contents

Introduction C-2

PLUG-INS MENU C-3

Auto Save C-3
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Gravity C-6
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Export Movie C-7
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υ Introduction

Select Plug-ins or Animation from the menu bar. 

A list of available menu command will displays. Select the name from the list to use that
ture. Hold down the Option key and select the name to display any options that are avai

The first time the Plug-in menu is selected, the top item in the menu, Last Plug-in, will b
grayed out. After selecting a menu command, the top item will then be the name of the m
command selected. This can be chosen by selecting the top item or typing Command - 
C-2
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PLUG-INS MENU

υ Auto Save

Select Auto Save to turn on the Auto Save feature. A dialog displays for you to enter a va
the Auto Save period.

Enter a value in minutes and click OK. A check mark will display next to the plug-in nam
show that Auto Save is on.

After the specified period, a dialog displays warning that it is time to save. The dialog off
the opportunity to turn Auto Save off, to close the dialog without saving, to automatically 
in future, or to save the document. To make this dialog disappear, but still save, just click
Automatically Save in Future.

To turn Auto Save off, select the plug-in name again from the plug-in menu.
C-3
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υ Ceilings

The Ceilings plug-in is used to quickly add ceilings to selected objects drawn with the 4 
or the Walls drawing tools.

1. Draw some walls using the 4 Walls or the Walls drawing tool:

2. Select the wall and choose Ceilings from the Plug-in menu.

3. A ceiling will then automatically be added to the document.

Note:  Ceilings are designed in such a way that they can only be seen if viewed from bel
C-4
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The Construct Idler plug-in is available as both a menu command plug-in and as an idle
in. See Construct Idler on page E-2 for details.

υ Floors

The Floors plug-in is used to quickly add floors to selected objects drawn with the 4 Wal
the Walls drawing tools.

1. Draw some walls using the 4 Walls or the Walls drawing tool:

2. Select the walls and choose Floors from the Plug-in menu.
C-5
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3. A floor will automatically be added to the walls.

Note: Floors are designed in such a way that they can only be seen if viewed from above

υ Gravity

The Gravity plug-in is available as both a menu command plug-in and as a plug-in modi
See Gravity on page H-6 for details.
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ANIMATION MENU

υ Export Movie

The Export Movie plug-in saves the current animation as a Quicktime movie.

1. Select Export Movie plug-in from the Animation menu

2. A standard Save dialog displays.

3. Enter a name and select a location to save the movie.

4. The animation will then be recorded frame by frame by the current renderer.

υ Light Start

The Light Start plug-in is used to animate the color and brightness of a light or group of 

To animate the color or brightness of a light, first select the light. The Light Start menu c
mand will then highlight if a light is selected. By selecting the menu command the light is
tagged to allow the lights color and brightness to animate when the current scene is ani

To set the Animate Color options, hold down the Option key and select the Light Start m
command. The Animate Color Options dialog will display:
C-7
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• Color Hue: Enter a value in the hue field to specify the number of degrees 
around the color wheel to move each second to select the colors to apply. 
The default is 10.

• Brightness: Enter a value between 0 and 360 to specify the percentage 
change in brightness of the color per second. Each second the brightness of 
the color will change by that set percentage value, cycling around to get 
darker, brighter and darker again. The default is 0.

• Strobe on time: Enter a value in seconds for the length of time the light 
should stay on.

• Strobe off time: Enter a value in seconds for the length of time the light 
should stay off.

Click OK to enter the options. They will remain as set until changed.

υ Light Stop

The Light Stop plug-in is used to stop the animation of a light or group of lights.

To stop an animating light, first select the light. The Light Stop menu command will then 
light if the light selected has a light animation. By selecting the menu command the light
then untagged causing the light to stop animating when the current scene is animating. 

Light Stop has no options or options dialog.

υ Object Color Start

The Object Color Start plug-in is used to animate the color applied to an object or group
objects.

To animate the color of an object, first select the object. The Object Color Start menu co
mand will then highlight, selecting the menu command will tag the object to allow the col
animate when the current scene is animating.
C-8
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To set the Animate Color options, hold down the Options key and select the Object Colo
menu command. The Animate Color Options dialog will display:

• Hue: Enter a figure in the hue field to specify the number of degrees around 
the color wheel to move each second to select the colors to apply. The 
default is 10.

• Saturation: Enter a value between 0 and 360 to specify the percentage 
change in saturation of the color per second. Each second the saturation of 
the color will change by the percentage value set. The default is 10 but to 
stop this effect set the value to 0.

• Brightness: Enter a value between 0 and 360 to specify the percentage 
change in brightness of the color per second. Each second the brightness of 
the color will change by the percentage value set. Cycling around getting 
darker, brighter and darker again. The default is 0 which has no effect on 
the color brightness.

Click OK to enter the options. They will remain as set until changed.

υ Object Color Stop

The object Color Stop plug-in is used to stop the animation of the color applied to an ob

To stop a color animating on an object, first select the object. The object Color Stop men
command will then highlight if the object or object in a group selected has an animated c
By selecting the menu command the object is then untagged causing the color to stop a
ing when the current scene is animating. 
C-9
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υ Object Texture Start

The Object Texture Start plug-in is used to animate a texture applied to an object. 

To animate a texture on an object, first select the object. The Object Texture Start menu
mand will then highlight if an object is selected and has a texture to animate. By selectin
menu command the object is now tagged to allow the object’s texture to animate when t
rent scene is animating. 

To set the Animate Texture options, hold down the Option key and select the Object Tex
Start menu command. The Animate Texture Options dialog will display:

• Velocity: Enter a figure in the Velocity field to specify how many times the 
applied texture should move around the object per second. The default is 
0.1

• Direction: To change the direction in which the texture moves, enter a 
value between 0 and 360 in the Direction field. If set at 90 degrees the tex-
ture will move from top to bottom, 180 degrees from left to right, 270 
degrees from bottom to top, and so on. The default is 0 degrees.

•  Rotation: Enter a value between 0 and 360 in this field to start the texture 
rotating. Each second the texture will rotate by the amount specified. The 
default value is 0 degrees. 

Click OK to enter the options. They will then remain as set until changed.
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υ Object Texture Stop

The Object Texture Stop plug-in is used to stop the animation of a texture applied to an o

To stop a texture animating on an object, first select the object. The Object Texture Stop
command will then highlight if the object selected has an animated texture. By selecting
menu command the object  is then untagged causing the texture to stop animating when
current scene is animating.

Object Texture Stop has no options or options dialog.  
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Appendix D

Plug-in Palettes

Plug-in palettes are accessed via the Palettes menu. Select the palette name
from the list to open it.
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υ Introduction

Click on Palettes in the application menu bar to display a list of available palettes. Selec
palette name from the list to open it.

The Tools, Info and Help palettes are not plug-in palettes but are part of the core applica
See Chapter 4 — Palettes on page 4-1 for details.
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Tabbed palettes

When a palette is opened it displays in a window with the palette name on a tab at the t
the palette.

Tabbed palettes can be stacked together by simply clicking on the palette tab and dragg
palette onto the tab area of another tab palette:

Both palettes then appear in the same palette. To access a palette click on its tab.

Any number of tabbed palettes can be stacked together, although in practice you may w
limit this to the number of tabs that are visible in a palette.
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To remove a tabbed palette from a stack, click on the palette tab and drag the palette on
desktop.

The palette will appear on its own, while the other palettes remain stacked together.

Click on a palette tab and hold down the mouse button to display the tab menu. This pro
an alternate method of selecting other palettes or of disconnecting a palette from the sta
D-5
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υ Align

The Align palette is used to align objects in any or all of the X, Y and Z axes.

1. Select Align from the Palettes menu to display the Align palette:

2. Select two or more objects in the document window then click on the buttons in th
Align palette to specify how the objects should be aligned in the X, Y and Z axes.

If one or more of the selected items are locked, they will not be moved, but other selected
will be aligned with the locked items. Locked items are treated as a single object for align
purposes.

The line of alignment relates to the object that is in the most extreme position in the rele
direction. For example, when choosing align right in the X-axis, the line of alignment is 
defined as the right edge of the bounding frame of the object furthest to the right.
D-6



ath, 
tion 

. Click-
lette. 

 will 
 points 

Enter 
υ Animation Path

The Animation Path palette is used to move an object or the camera along a specified p
over a set time. To use the Animation Path palette you will first need to create an Anima
Path with the Anmation Draw Path Tool. 

Select Animation Path from the Palettes menu to display the Animation Path palette:

Animation Path Controls

  +Object

The +Object button will enable when both an object and an animation path are selected
ing this button will cause the object have tween points added in th Animation Tweener pa
These points will correspond to the Animation Path selected.

 +Camera

The +Camera button will enable when an animation path is selected. Clicking this button
cause the camera to have tween points added in the Animation Tweener palette. These
will correspond to the Animation Path selected.

 Start Time

The value displayed in the Start Time field is the Animation Path inital value in seconds. 
a value and press the Return, Enter or Tab key to change the Start Time value.

 End Time
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The value displayed in the End Time Field is the Animation Path final value in seconds. E
value and press the Return, Enter or Tab key to change the End Time value. 

 Reset

The reset button when clicked will change the start and end time value to the current do
ments animation values. 

 Display Animation Paths

Controls the visibility of an Animation Paths in the current document.

Object Options

 Rotate

The object is rotated as it moves along the path so that it maintains its orginal orientatio
relation to the path.

 Scale

If the Animation Path has been scaled at any point using the Animation Edit Path tool, th
object will also be scaled at that point. 

 Twist

If the Animation Path section has been rotated at any point using the Animation Edit path
the object will also be rotated around the path at that point. 

Camera Options

Note: To view the effect of the following different camera options open the NaviCam pale
the animation is running.

Animate Camera

 Along Path

The camera is moved along the path.
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 Fixed Point

The camera is moved along the path with a fixed view point.

 Fixed Direction

The camera is mved along the path with its view point in a fixed direction.

Animate View Point

 Along Path

The camera’s view point is moved along the path with the camera following behind. 

 Fixed Point

The view point is moved along the path while the camera is in a fixed position.

 Fixed Direction

The view point is moved along the path while the camera follows behind at a fixed distan
and fixed to a set direction.

Note: The object or camera is not linked to the path in any way. if the Animation Path is 
sedited, the animation for the camera will not be changed. To update an animation of an
or camera along a new path just click the appropate button and the new animation will re
the old animation. 

υ Animaton Player

The Animation Player palette is used to control the display of animation in the documen

Select Animation Player from the Palettes menu tp display the Animation Player palette:
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AnimationPlayerControls

 Move To Start

Click on the Move to Start button to move to the beginning of the timeline. 0/0 will be dis
played in the Time field, and slider on the timeline bar will displayer at the left end of the

 Play Backward

Click on the Play Backward button to play an animation in reverse direction.

 Pause

Click on the Pause button to pause an animation playing.

 Play Forward

Click on the Play Forward button to play an animation.

 Move to End

Clicking on the Move to End button to move to the end of the timeline. The value set in t
Duration field will be displayed in the Time field, and the slideron the timeline bar will disp
at the right end of the bar.

 Timeline Bar
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The slider bar represents the timeline for the animation. Click on the slider, hold down th
mouse button and drag the slider right or left to move to a different position on the timeli

 Start Time

The value displayed in the Start Time field is the animation’s start position in seconds. E
value and press the Return, Enter or Tab key to change the Start Time value.

 Current Time

The value displayed in the Current Time field is the animation’s current position in sec-
onds.Enter a value and press the Return, Enter or Tab key to change the Current Time v

 End Time

The value displayed in the End Time field is the animation’s current position in seconds.
a value and press the Return, Enter or Tab key to change the EndTime value.

 Once

Click on the Once radio button to specify that an animation should run once through to th
then stop.

 Cyclic

Click on the Cyclic radio button to specify that an animation should play constantly, runn
through to the end then returning to the start to play again.

 Oscillate

Click on the Oscillate radio button to specify that an animation should play constantly, run
through to the end, playing backward from the end to the start, and playing again.

 Speed Bar

The slider bar represents the speed for the animation. Click on the slider, hold down the 
button and drag the slider left or right to move to a different speed of animation. The cen
point alwas represents normal speed.
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 Minimum Speed

The value displayed in the Minimum Speed field is the animation’s slowest possible fram
gression in seconds. Enter a value and press the Return, Enter or Tab key to change th
mum speed value.

 Current Speed

The value displayed in the Current Speed field is the animation’s current frame progess
seconds. Enter a value and press the Return, Enter or Tab key to change the minimum 
value.

 Maximum Speed

The value displayed in the Maximum Speed field is the animation’s fastest possible fram
gession in seconds. Enter a value and press the Return, Enter or Tab key to change the
mum speed value.

υ Animation Tweener

The Animation Tweener palette is used to specify the position, size and rotation of the ob
the position, direction, zoom factor and view type of the camera at a specific time. The s
fied position is called a tween point, the positions between the set tween points are calc
by the computer.

Select Animation Tweener from the Palettes menu to display the Animation Tweener pal
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Animation Tweener Controls 

 Move To Start

Clicked on the Move to Start button to move to the beginning of the timeline. 0.0 will be 
played in the Time field, and the slider on the timeline bar will display at the left end of th

 Move to Previous Tween

Click on the Move to Previous Tween button to move the timeline to the previous tween 
point in the current animation.

 Play Backward

Click on the Play Backward button to play the current animation in reverse direction.

 Pause

Click on the Pause button to pause the current animation.

 Play Forward

Click on the Play Forward button to play the current animation.

 Move to Next Tween

Click on the Move to Next Tween button to move the timeline to the next tween time poin
the current animation.

 Move to End

Click on the Move to End button to move to the end of the timeline. The value set in the 
tion field will be displayed in the Time field, the slider on the timeline bar will display at th
right end of the bar.

 +Object
D-13



e and 

 posi-

peci-

ight-

y.

ward 

 
in the 

me  is 
rent 
Use the +Object button to add a tweenpoint for an object. This specifies the position, siz
rotation of the selected object at a particular time.

 +Camera

Use the +Camera button to add a tween point for the current camera. This specifies the
tion, direction, zoom factor and camera type at a particular time.

 +Ambient

Use the +Ambient button to add a tween point for the current ambient light levels. This s
fies the brightness, color and if it is on or off at a particular time.

 +Sun

Use the +Sun button to add a tween point for the sunlight. This specifies the position, br
ness, color and if it is on or off at a particular time. 

Note: To delete a tween point, select the desired triangle marker and press the Delete ke

 Tween increment time value

The Tween increment time value specifies the time in seconds the timeline will move for
after a tween point has been added.

Note: Holding down the Option key stops the timeline moving forward.  

 Timeline

In the lower part of the Animation Tweener palette a table displays the list of objects with
tween points which are displayed in the Object Name column. Objects can be selected 
document window by selecting an Object name in the list and vice versa.

The time in seconds is displayed in the first line of the table, and the current animation ti
marked with a blue thumb at the top of the table and a vertical red line. To move the cur
animation time 

 Zoom
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Using the zoom controls at the bottom left of the palette to zoom in and out on the table
playing a longer or shorter section of the timeline.

υ Axis

The Axis palette is used to display the current orientation of the front window’s camera.

Select Axis from the Palettes menu to display the Axis palette:

Select the Rotate tool in the Tool palette, click on the document grid and, holding down 
mouse button, drag to rotate the grid. Notice that the positions of the axes in the Axis pa
are updated to reflect the new orientation of the grid.
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Click on the palette’s zoom button to extend the Axis palette:

The axes are listed and the color of each axis shown. Next to the axis name is a checkb
is used to display or hide the axis. Checking the check boxes on or off to specify which 
should be displayed in the palette.

υ Color

The Color plug-in displays a color picker, so that an object’s color or the default color ca
changed easily.

1. Select Color from the Palette menu to display the Color palette:

2. To change the color of an object, several objects, or a group, make a selection in 
document window. If nothing is selected, the default color will be changed.

3. Choose a color from the Color palette by clicking on the color wheel and/or adjus
the brightness slider bar and values for Red, Green, Blue, Hue, Saturation and Va

4. Click on the current color button to display the system color picker(s) if necessary

Note: Colors can be dragged to and from the current color button.
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υ Color Palette

The Color Palette plug-in provides a repository for 12 colors.

1. Select Color Palette from the Palette menu to display the Color Palette:

2. To use a color in the Color Palette, drag and drop it onto an object, the background
or color box in the Info Palette, or select an object in the document window and clic
a color in the Color Palette.

3. To change a color in the Color Palette, drag and drop a new color over an existing
or, when nothing is selected in the document, click on a color to open the color pi
and choose a new color.

υ Cursor Options

The Cursor Options palette allows you to control the alignment and positioning of objects
other objects, and the display and positioning of the cursor. Select Cursor Options from 
Palettes menu to display the palette. Click on the shrink/expand button at the top right o
palette to show or hide the lower section.
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Snapping Options

Snapping is the alignment of points with other points. When positioning objects, snap lin
will display and a sound will play when the snap points of the selected objects are aligne
the snap points of unselected objects.

• Enable Snap: Click on this check box to turn the Snapping features on or off. Alternativ
hold down the Control key and press the space bar to switch Snapping on or off.

• Snap to Bounding Box: Click on this check box to activate the eight corners of each obje
bounding box as Snapping points.

• Snap to Mid Points: Click on this check box to activate the mid points of each object’s 
bounding box as Snapping points, i.e. The points half way between the eight corner 
of the bounding box.

• Snap to Hot Spots: Click on this checkbox to specify that an object’s Hot Spots should 
activated as Snapping points. Hot Spots are points in addition to the corners and m
points of an object’s bounding box. These are automatically added to wall objects an
be added to door and window objects. Hot Spots are added to wall objects at the to
bottom of the wall at each corner. When placing doors and windows in a document,
Windows and Doors palette includes a check box allowing you to choose whether to
Hot Spots or not. If added, Hot Spots are positioned at the points where the window
door intersects with the wall.

• Multiple Snap Lines: If this option is checked on, snap lines will display for all current 
alignments. If checked off, snap lines will display only for the first alignment found in
each axis.

• Play Snap Sounds: Check this option on to play sounds according to the snapping statu
objects being positioned. Three different sounds play in the following circumstances
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If a point is aligned with, but not snapped to, another point.

If a point is snapped to another point.

If a point in no longer aligned with or snapped to another point.

• Snap Line Color: Click on this box to display the Color Picker and select the color used
display the snapping lines.

3D Cursor

• Show Cross Hairs: Check this option to display cross hairs showing the position of the 
sor in the document in 3D space.

• Floating Cursor:  The cursor defines a position and an orientation for entering new obj
and usually snaps to the surface of any object below the cursor arrow. Check this op
specify that the cursor should not snap to the surface of any object below it, and shou
orientate itself in relation to that surface.

υ Libraries

The Libraries palette displays libraries of furniture items, doors, windows, textures, color
that can be used in your 3D scene.

Select Libraries from the Palette menu. The first time the Libraries palette opens, it open
the default libraries of the program. Every time after this the Library palette retains the li
the libraries selected:
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Selecting Library Items

When you click on an item that is stored in a library it will be outlined with a black rectang
show it is selected:

Storing Data

3DMF, PICT, and data in various other image formats can be stored in libraries. Interiors
includes several libraries of furniture and accessory items, doors and windows, colors a
tures, but you can also use the Libraries palette to store your own items. To do this drag
drop objects/groups of objects from Interiors into a library. You can also visit the Microsp
website to download more libraries, See Microspot Library Download on page 3-36.

Naming Items

Items are displayed in a library in the order in which they were entered.

If an item has a name attached to it, this name is displayed in the Name field at the bott
the palette when the item is selected. Unnamed items will display as untitled.

To name or rename an item, select its icon and enter a name in the Name field. Press th
or Return key, select another object or click on an empty space in the library and the ite
be updated with its new name.

Retrieving Data

To retrieve data from a library, drag and drop an item directly into your Interiors docume
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Find

Library items can be searched for by name. Enter text into the Find field at the top right 
Libraries palette. The first item found that matches the entered text will be selected:

Note: The Libraries palette searches for names that match or start with the name you en

Window Controls

Zoom In/Out

The Zoom controls at the bottom left of the palette can be used to increase/decrease the
the palettes contents:
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Horizontal/Vertical Arrows

• Horizontal Arrow: In the By Icon view, click on this button to display the Libraries pale
with a horizontal scroll bar. In the By List view, click on this button to display the prev
to the left of the item list:

• Vertical Arrow: In the By Icon view, click on this button to display the Libraries palette 
with a vertical scroll bar. In the By List view, click on this button to display the previe
above the item list:

Delete Button

• Delete: The Delete button removes the current selected library item:
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File Menu

New

Select New to open a new library. The standard dialog will display, allowing you to enter
name for the new library and specify a location to save it. A new, empty library will displa
the Libraries palette:

Open

Select Open to open an existing library. A standard Open dialog will display for you to se
the library to open. The selected library will display in the Libraries palette.

Open Defaults

On selecting Open Defaults all the programs existing default libraries will be displayed in
Libraries palette. 
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Close

Choose to close the current library. The Libraries palette save the library file whenever yo
data, so you do not need to save any changes. The Libraries palette will remain open an
display the contents of any other open libraries.

Close All

Choose to close all open libraries. The Libraries palette will remain open but will be emp

View Menu

By Icon

Select By Icon from the View menu to display picture previews of a library’s contents. 
Although the items’ names will not be displayed, you may still search for items by name 
the Find field at the top right of the Libraries palette.

By List

Select By List from the View menu to list a library’s contents by name. When By List is 
selected you can also choose whether to see a preview of an item when it is selected in

• Preview above: The preview is displayed above the list:
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• Preview to left: The preview is displayed to the left of the list:

• No preview: No preview of selected items is displayed:

Display Menu

The display menu lists all the libraries currently open. Select a library’s name from the li
display it or choose Show All to display the contents of all the open libraries in the order
which they were opened.
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υ Lights

The Lights Palette is used to control the various lighting features available in the applica
Select Lights from the Palettes menu to display the palette:

Note: The Preferences dialog, accessed from the Edit Menu, contains a check box for G
Lights. If the Global Lights control is turned on, any changes made via the Lights palette
affect the whole document. If the Global Lights control is turned off, making changes in t
Lights palette will affect only the current window. See Preferences on page 3-5 for further 
details.

Spot/Point Brightness

Lights are placed in documents by dragging and dropping light objects or furniture items
including lights into the document. When a light is placed in a document, its color, bright
spread and sharpness can be adjusted via controls in the Info Palette. See Info Palette on page
4-17 for further details.

• To manipulate all point or spot lights at once, use the Spot/Point Brightness slider co
in the Lights Palette.

• Use the checkbox to the right of the slider bar to turn all the point or spot lights on o

Ambient Brightness

Ambient light is the equivalent of daylight. It is a diffused light that has no specific point o
origin and casts no shadows.

• Use the Ambient Brightness slider bar to adjust the brightness of the ambient light.

• Click on the color box to display the Color Picker and select a color for the ambient l
or drag a color onto the color box.
D-26



nlight 

ht 

or 

 dis-
uch as 
• Use the checkbox to the right of the color box to turn ambient light on or off.

Sun Brightness

By default, sunlight shines from the South East at an angle of 45°. The direction of the su
can be adjusted using the Sun Direction plug-in. See Sun Direction on page H-9 for further 
details. Sunlight will affect your view of an object, and some surfaces will reflect more lig
than others.

• Use the Sun Brightness slider bar to adjust the brightness of the sunlight

• Click on the color box to display the Color Picker and select a color for the sunlight, 
drag a color onto the color box.

• Use the checkbox to the right of the color box to turn sunlight on or off.

Show Lights Markers

Use this checkbox to specify whether Point and Spot Light Markers should be hidden or
played. The effects of the lights will be apparent regardless. Non-interactive renderers (s
the Microspot Renderer) will not display light objects whether they are hidden or not. See 
Appendix I — Microspot Plug-in Renderers on page I-1 for more details.

υ NaviCam

The NaviCam palette provides a way of controlling the camera position and view.

Select NaviCam from the Palette menu to display the NaviCam palette.

Height Area
Position Plan

Zoom

Position Buttons

Grid Height

Clipping Planes
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The red square displayed in the palette, both in the height area and in the position plan,
sents the camera. The line from this square shows the camera view direction and at the
this line is the look at point or point of interest.

Height

Use the controls in the Height Area to adjust the position of the camera, or point of intere
the Y dimension. 

The long green line in the Height Area represents the grid height. The lines above it repr
height as determined by the size of the grid and each grid square.

• Click on the camera square and move it up or down to change the camera height w
maintaining the point of interest.

• Click on the view direction line (or anywhere in the Height Area except the camera 
square) and drag up or down to change the height of the point of interest without cha
the camera height. This is the same as tilting the camera.

• Hold down the Option key, click anywhere in the Height Area and drag up or down to
adjust the height of the camera and move the point of interest relative to the camera
height.

If the camera is moved out of the height range shown, the display will be rescaled so tha
camera square can still be seen. When the camera is moved back into range, the display
rescaled again.

Position

Use the controls in the Position Plan to adjust the position of the camera or the point of in
in the X and Z dimensions.

The Position Plan displays an image of the 3D scene in plan view.

• Click on the camera square and drag to change the position of the camera while ma
ing the point of interest.

• Click on the view direction line (or anywhere in the Position Plan except the camera
square) and drag to change the position of the point of interest without moving the ca
position. This is the same as turning the camera.

• Hold down the Option key, click anywhere in the Position Plan and drag to move the
era and move the point of interest relative to the camera position. This is the same a
step and crab movements of the camera.
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If the camera is moved out of the plan shown, the display will be rescaled so that the ca
square can still be seen. When the camera is moved back into range, the display will be
caled again.

Zoom

Click on the Zoom button and drag up or down to zoom in or out on the scene.

Clipping Planes

The Clipping Plane controls are used to adjust the camera’s front (Hither) and back (Yon
ping planes.

Although the clipping planes themselves are invisible, the effect they have on objects in 
document can be seen. The front (Hither) and back (Yon) clipping planes can be set so th
view only a section of the document. Any objects or parts of the objects closer to the cam
than the front (Hither) clipping plane, or further from the camera than the back (Yon) clip
plane, will not be visible.

Hither Clipping

Click on the Hither Clipping button and drag up to move the front (Hither) clipping plane 
ther away from the camera or down to move the front (Hither) clipping plane towards the
era.

Yon Clipping

Click on the Yon Clipping button and drag up to move the back (Yon) clipping plane fu
away from the camera or down to move the back (Yon) clipping plane towards the came

Position Buttons

Use the position buttons to move either the camera or the point of interest to predefined
tions.

• Click on the position buttons to move the camera while maintaining the point of inter
0° moves the camera to directly behind the point of interest, 90° to the right, 180° dir
in front of, 270° to the left, and so on.
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• Hold down the Option key and click on the position buttons to move the point of inte
while maintaining the camera position. 0° moves the point of interest to directly beh
the camera, 90° to the right, 180° directly in front of, 270° to the left, and so on.

• Click on the ‘Mid’ button to move both the camera and the point of interest to predet
mined locations. The point of interest is positioned at the centre of the grid. The cam
placed half way between the centre and the side of the grid, directly in front of the po
interest. The camera will be at approximately eye height and tilted down slightly.

υ Nudge

Use the Nudge palette to move or rotate an object by a specified amount.

Select Nudge from the Palettes menu to display the Nudge palette:

Move

1. Select an object in the document window.

2. Enter a value in the Move box in the Nudge palette. The units used will depend on
set for the document in the Options menu. 

3. Click on the control buttons to choose the direction in which to move the selected
object. The direction relates to the current view.
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Rotate

1. Select an object in the document window.

2. Enter a value in degrees in the Rotate box in the Nudge palette.

3. Click on the control buttons to choose the direction in which to rotate the selected
object. The direction relates to the current view.

υ  Renderer Options

The Renderer Options plug-in palette is used to control the way that the document is disp
Choose Renderer Options from the Palettes menu to open the palette:

Move Up

Move Down

Move Left Move Right

Move Closer Move Further Away

Rotate Up

Rotate Down

Rotate Left Rotate Right

Rotate Anticlockwise Rotate Clockwise
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Camera

Select Perspective or Orthographic from the Camera pop-up menu.

• Perspective: Objects are displayed in perspective mode to give the illusion of depth. P
lel lines are drawn so that if extended, they would converge at a given point:

• Orthographic: Objects are displayed in Orthographic mode. Parallel lines remain para
regardless of the distance they are supposed to be from the camera:

Renderer

Click on the Renderer popup menu to display any available renderers.
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• Wire Frame: The surfaces of objects are not filled; only the edges of the surfaces are 
played:

• Interactive: Objects in the document are rendered using the programs interactive ren

• Microspot Preview Renderer: The scene is rendered using the Microspot non-interactive
renderer to produce a fast preview render of the scene with lighting and shadows. See 
Appendix I — Microspot Plug-in Renderers on page I-1 for more details.

• Microspot Renderer: The scene is rendered using the Microspot non-interactive render
produce a high quality final render. See Appendix I — Microspot Plug-in Renderers on 
page I-1 for more details.

Renderer Options

To the right of the Renderer popup menu is a button for Renderer Options. This is only ac
a non-interactive renderer is installed and selected. Click on the button to display any ava
options for the currently selected non-interactive renderer.

Note: Holding the Option key down while selecting the renderer will also display any opti
available.

Style

The Style pop-up menu is not available when the Wire Frame renderer is selected. Sele
of the following options from the menu:

• Filled: All surfaces are filled and rendered. Objects appear to be solid.
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• Edges: Only the edges of objects are rendered. This is different from Wire Frame mo
that lines are rendered according to the orientation of the object and any light sourc
rather than the lines being displayed as one solid color:

• Points: Only the vertex points of objects are rendered. Points are rendered according
orientation of the object and any light sources:

Shading

Select Plain, Smooth or Best from the Shading pop-up menu.
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• Plain: Surfaces are filled but not smoothed and steps of color can be seen within som
objects. Shading is applied according to the angle of the surface and any light sourc
will affect the object:

• Smooth: Surfaces are filled and smoothed. Shading is applied according to the angle 
surface and any light sources that will affect the object:
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• Best: Surfaces are filled and smoothed. Shading is applied according to the angle of 
surface and any light sources that will affect the object. This option also displays the
reflections of any lights:

Backface

The backface of an object is the side that faces away from the camera.

Select Show, Remove or Flip from the pop-up menu.

• Show: Select this option to show the backface of an object. This will not make any vis
difference if the object surfaces are filled, but if you are viewing the objects in wire fr
mode, you will be able to see the wire frame on the backface of the object:
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• Remove: Select this option to hide the backface of an object. This will not make any d
ence if the object surfaces are filled, but if you are viewing an object in wire frame m
its backface will not be displayed:

• Flip: The Flip option flips the backface so that the outside surface is now on the insid
This does not affect the shape of the object, but may alter the way it is rendered:

Show Grid

Documents are automatically displayed with a grid to help you design and position objec
3D. When this option is enabled, the grid will be displayed. Uncheck this option to hide t
grid.

Show Markers

When text and sound markers are placed in a document, you can choose whether or no
play them. Check the Show Markers option to display markers, or leave it unchecked to
markers. There is no marker tool in Interiors
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υ Textures

Use the Textures Palette to manipulate a texture applied to an object.

Select Textures from the Palettes menu to display the Textures palette:

The contents of the palette will be grayed out unless an object with a texture applied to 
selected.

When a texture is applied to an object it is scaled/stretched to fit once on each surface. T
ture can then be manipulated using the controls in the Textures palette.

Textures Palette Options

• Rotation: Enter a value between 0 and 359.9 in the rotation field and press the Retur
Enter or Tab key or use the rotation slider to adjust the degree of rotation of the text
applied to the object.
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• Offset: Select Offset from the pop-up menu and the two slider bars to the right of the
up menu will relate to horizontal and vertical offset. The values for horizontal and ver
offset can be linked by clicking on the constrain box to the right of the slider bars.

Horizontal Offset: Enter a value between 0 and 1 in the Horizontal Offset field and p
the Return, Enter or Tab key or use the slider bar to move the texture across the ob
a horizontal direction.

Vertical Offset: Enter a value between 0 and 1 in the Vertical Offset field and press 
Return, Enter or Tab key or use the slider bar to move the texture across the obje
vertical direction.

• Scale: Select Scale from the pop-up menu and the two slider bars to the right of the p
menu relate to horizontal and vertical scale. The values for horizontal and vertical sc
can be linked by clicking on the constrain box at the right of the slider bars.

Horizontal Scale: Enter a value between 0 and 25 in the Horizontal Scale field and p
the Return, Enter or Tab key, or use the slider bar to change the horizontal scale 
texture on the object.

Vertical Scale: Enter a value between 0 and 25 in the Vertical Scale field and press 
Return, Enter or Tab key or use the slider bar to change the vertical scale of the t
on the object.

• Flip Horizontal: Check the Flip Horizontal check box to flip the texture applied to the 
object around the horizontal axis.

• Flip Vertical: Check the Flip Vertical check box to flip the texture applied to the object 
around the vertical axis.
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• Clamp X: Check the Clamp X check box to prevent the texture being repeated in the 
axis. The texture offset can then be adjusted to position the strip of texture on the su

• Clamp Y: Check the Clamp Y check box to prevent the texture being repeated in the Y
The texture offset can then be adjusted to position the strip of texture on the surface

• If the texture is clamped in both the X and Y axes it is not repeated in either direction
texture can then be scaled and positioned on the surface as desired.
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• Play Movie: This option is only available if a movie has been applied to an object as a
ture. Click on the Play Movie button to start the movie playing. Note: the movie will o
play if animation is turned on and is not paused. If animation has been turned off or
paused via the Animation Player palette (see Animation Path on page D-7)0 the movie 
will not play until animation is turned on again.

• Stop Movie: This option is only available if a movie has been applied to an object as a
ture. Click on the Stop Movie button to stop the movie playing.

• Import: Click on the Import button to display a standard dialog that allows you to sele
PICT, TIFF, JPEG, GIF, PICT clipping or movie file to import as a texture or else just 
and drop directly onto objects in the document window, as long as the Textures pale
plug-in is loaded.

• Sound: Use the Sound control to change the volume of the sound of any movie appli
a texture on a selected object. Click on the sound icon and a pop-up menu displays.
the level of sound required.

υ Tripod

The Tripod palette provides an alternate method to the NaviCam palette for a way of cha
the view in the current document window. 

Select Tripod from the Palettes menu to display the palette:

Height

Step/Crab

Zoom

Pan/Tilt

Look At Selected

Zoom Out Zoom In

Adjust Height

Home View

Crab

Step

Crab

Pan/Tilt

Hither Clipping

Yon Clipping
D-41



e con-
n most 
d with 

cts in 
so that 
 cam-

 clip-
The Tripod palette displays a graphic of a camera on a tripod. A variety of buttons provid
trols for manipulating the camera, the above dialog shows how those controls are used. I
cases click on the button to perform the relevant action. When using those buttons marke
italic text, click on the button and drag to perform the desired action.

• Look At Selected: Select an object in the document and click on the Look At 
Selected button to position the camera to centre the selected object in its view.

• Zoom: is used to narrow or widen the focus of the camera lens

• Height: The Height controls are used to change the height of the camera.

• Pan/Tilt : The Pan/Tilt controls are used to change the camera’s angle by turning 
it left and right or tilting it up and down.

• Step/Crab: The Step/Crab controls are used to move the camera closer, further 
away, left, and right.

• Home View: Click on the Home View button to return the camera to its initial 
position (the view displayed when a new file is opened).

• Hither Clipping : Click on the Hither Clipping button and drag up to move the 
front (Hither) clipping plane further away from the camera or down to move the 
front (Hither) clipping plane towards the camera.

• Yon Clipping: Click on the Yon Clipping button and drag up to move the back 
(Yon) clipping plane further away from the camera or down to move the back 
(Yon) clipping plane towards the camera.

Note: Although the clipping planes themselves are invisible, the effect they have on obje
the document can be seen. The front (Hither) and back (Yon) clipping planes can be set 
you view only a section of the document. Any objects or parts of the objects closer to the
era than the front (Hither) clipping plane, or further from the camera than the back (Yon)
ping plane, will not be visible.
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υ Windows and Doors

The Windows and Doors palette is used to accurately position windows and doors in a w
Open the Windows and Doors palette by selecting its name from the Palettes menu, and
a window or door item in the document.

• Centre in wall: Click on this button to centre a window or door in the wall. Doors will b
positioned in the centre of the length of wall but will remain on the grid, windows wil
positioned centrally in both dimensions.

• Reverse: Click on this button to mirror a window or door about the vertical axis. Note t
this does not actually rotate the item, just changes its appearance.

• Measurements: The dimensions of the window/door, the length of the wall on either sid
the window/door and the height of the window/door above the grid displays in fields i
palette. Type in new values to change these measurements as required. When you 
a field to enter/revise values, a black arrow shows which dimension that value refers
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Appendix E

Idler Plug-ins

Idler plug-ins have no interface and run constantly in the background when
loaded.
Table of Contents
Construct Idler D-2
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Return to main table of contents
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υ Construct Idler

The Construct Idler has two functions:

• Performing CSG (Constructive Solid Geometry) Boolean calculations. CSG operations allow 
one geometry to cut into another — enabling you to see into a room through a windo
example. The calculation is performed each time an object with a CSG attribute is 
changed, and may take a few seconds depending on the complexity of the documen
objects must have the appropriate CSG attributes applied to them, by using a plug-in
allows CSG attributes to be applied to objects, or by using library items that already 
CSG attributes applied. Door and window library items supplied with the application,
walls drawn with the wall drawing tools, include the correct CSG attributes.

• Automatically simplifying objects as rendering speed decreases. When the Construct Idler is 
checked on in the Plug-in menu and rendering speed falls below 4 renders per seco
plug-in starts to simplify the objects in the scene that contain the most triangles, by tu
them into cubes. This allows you to continue to edit a complex document in real time,
on one of the slower computers. Any selected items, windows and doors are not affe
by this process. Items are re-drawn in full once the editing action is complete.
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Appendix F

Plug-in Tools

Individual plug-in tools are discussed in Appendix G — Plug-in Geometries
and Appendix H — Plug-in Modifiers. This appendix provides information
relevant to both types of plug-in tool.
Table of Contents

Introduction F-2

Configuring The Tools Palette F-2

Tool Options F-3
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υ Introduction

Plug-in tools are either plug-in geometries or plug-in modifiers. See Appendix G — Plug-in 
Geometries on page G-1 and Appendix H — Plug-in Modifiers on page H-1 for details o
vidual plug-ins. When loaded, plug-in tools appear in the Tools palette and can be position
the palette by the user as discussed below.

υ Configuring The Tools Palette

When Interiors is launched with all the plug-ins loaded, the plug-ins are placed in the To
palette in a default order.

The Tools palette is configurable, so you can move tools around to position them in the 
tion or group that is most convenient or logical for you.

Configure the Tools palette in the following way:

• Click on a tool and hold down the mouse button to display a pop-up menu showing 
other tools in the stack (if any). Select the name of a tool in the pop-up menu to sele
tool and bring it to the top of the stack.

• To move a tool, hold down the Command key, click on the tool and drag it to a new l
tion.

• Drop a tool onto another tool to stack them together.
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• Drop a tool onto the four selection tools at the top of the palette to separate it from a 
of stacked tools and add it to the top of the tool palette as an individual tool.

υ Tool Options

To open a dialog showing any options available for a tool, use either of the following me

• Hold down the Option key and select the tool in the Tools Palette.

• Click on the tool in the Tools palette and hold down the mouse button. Select the sam
from the pop-up menu that displays.

Note: There are no options available for the Arrow, Rotate, Rectangular Marquee and Ha
tools.
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Appendix G

Plug-in Geometries

Plug-in Geometries are plug-in tools that are used to create objects. When
installed they are located in the Tools palette.
Table of Contents

Introduction G-2

4 Walls G-3

Animation Draw Path G-5

Point Light G-7

Spot Light G-8
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υ Introduction

When loaded, Plug-in Geometries appear in the Tools palette. The position of each plug
within the Tools palette will depend on how the user has configured the palette. See Configur-
ing The Tools Palette on page F-2 for more details. The default arrangement is shown below

Select the plug-in tool to use by clicking on the icon of that tool in the Tools palette.

4 Walls

Animation Draw Path

Walls

Point Light

Spot Light
G-2
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υ 4 Walls

The 4 Walls plug-in is used to draw a regular, four-walled room. Walls are always drawn
pendicular to the grid and resting on the grid.

1. Select the 4 Walls plug-in from the Tools palette. The view will change to show an
orthogonal, top view.

2. Click on the grid and, holding down the mouse button, drag to draw 4 walls:

3. Release the mouse button and the Edit options dialog displays:
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4. If necessary, enter values in the Width, Depth, Height and Wall thickness fields to
ify the width and depth of the room, the height of the walls and the wall thickness.

5. Click OK. The view will change back to the previous view, and the walls will display
the dimensions specified. If the walls are the first items drawn, the room will be au
matically centred on the grid.

To change the default settings for the 4 Walls plug-in, hold down the Option key and sele
4 Walls tool. The Wall Options dialog displays:

• Wall thickness: Enter a value to specify the default thickness for walls.

• Wall height: Enter a value to specify the default height for walls.
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• Internal measurement: Click on the Internal measurement radio button to specify that v
ues entered in the Entry options dialog (the dialog that displays after walls are draw
relate to the measurements of the internal walls.

• External measurement: Click on the External measurement radio button to specify that 
ues entered in the Entry options dialog (the dialog that displays after walls are draw
relate to the measurements of the external walls.

• Show info editor: Check the Show info editor check box to specify that the Entry optio
dialog should appear after walls are drawn. Uncheck this check box if you do not wa
this dialog to display.

Note: The size, position and rotation of the walls are locked on entry. If you unlock the wa
using the controls in the Info palette, the width and depth of the room, the height of the w
and the rotation of the room can be adjusted using the Info palette or the Arrow tool, but
wall thickness will be scaled proportionally. See Info Palette on page 4-17 for more informa
tion.

υ Animation Draw Path

The Animation Draw Path plug-in is used to draw animation path geometries.

Select the Animation Draw Path tool, position the cursor where you want to begin drawin
click the mouse button to place a vertex point, move the cursor to a new point and click 
To finish the line, double click.
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To draw an arc, hold down the Option key and click at the point that will represent the cen
a circle. Release the Option key and mouse button and move the cursor ready to place t
point. The arc will display. Click to place the next point at the end of the arc:

To draw a Bezier curve, click and drag the cursor:

To draw a spline curve, hold down the Option key and click and drag the cursor:

• To delete the last point placed use the Delete key. 

• To complete an Animation Path double click.
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• To constrain the path to the X, Y, or Z axis hold down the Shift key. 

• To move in the Z dimension, hold down the Control key.

To change the default settings for eye level height and locking for the Animation Draw P
plug-in:

1. Hold down the Option key and select the Animation Draw Path tool to display the 
mation Draw Path Options.

2. Select the Lock to eye level checkbox to control if an Animation Path geometry wi
locked to the X-Z dimension at the value of eye level height.

3. Enter a value in the Eye level height field(s) to specify the position in Y coordinate
which the Animation Path geometries will be drawn.

υ Point Light

Use the Point Light plug-in to place point lights in your Interiors document. Point lights rad
light in all directions.

Note: Light objects are visible by default. If you have turned off the Show Light Markers 
option in the Lights palette, the light objects will not be displayed. See Lights on page D-26 for
more details.

Select the Point Light tool in the Tools palette and click in the document window. The lig
placed at the point clicked.
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A point light is displayed as a small cube and when selected has a bounding sphere. Po
lights cannot be resized, but can be moved and rotated like other objects. Note that rota
point light will not have any effect on the lighting in the document.

Hold down the Command key when placing a point light and, if the scene is rendered us
Microspot renderer that draws shadows, that particular light will not cast any shadows.

Hold down the Option key when placing a point light and a light with a negative brightne
value will be placed in the document. The negative brightness value can be adjusted us
Brightness slider in the Info palette as usual. To adjust a light with a negative brightness
so that it has a positive brightness value, set the brightness to 0 in the Info palette, then
brightness as for an ordinary point light.

The Info Palette is used to specify the color and brightness of a selected point light. See Info 
Palette on page 4-17 for further details.

The color of the point light sphere is set in the Preferences dialog. If the color chosen is
(default) light markers take on the color of light they represent. See Preferences on page 3-5 
for further details. 

υ Spot Light

Use the Spot Light plug-in to place spot lights in your Interiors document. Spot lights ha
directional shade around them which can be rotated to direct light in a specific direction.

Note: Light objects are visible by default. If you have turned off the Show Lights option in
Lights palette, the light objects will not be displayed. See Lights on page D-26 for more 
details.

Select the Spot Light tool in the Tools palette.

• To place a spot light at a specific position in the document: move the cursor to that point, click
and release the mouse button.

• To direct the light as you place it in the document: click on the point you wish the spot light
to shine and drag the light into position before releasing the mouse button. Hold dow
G-8
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Shift key when dragging the light to constrain it to an axis perpendicular to the surfa
clicked on.

A spot light is displayed as an open, four sided pyramid with a short black line to indicate
direction the light is pointing. When a light is selected it displays with a bounding sphere.
lights cannot be resized, but can be moved and rotated like other objects.

Hold down the Command key when placing a spot light and, if the scene is rendered us
Microspot renderer that draws shadows, that particular light will not cast any shadows.

Hold down the Option key when placing a spot light and a light with a negative brightnes
value will be placed in the document. The negative brightness value can be adjusted us
Brightness slider in the Info palette as usual. To adjust a light with a negative brightness
so that it has a positive brightness value, set the brightness to 0 in the Info palette, then
brightness as for an ordinary point light.

The Info Palette is used to specify the color, brightness, spread and sharpness of a selec
light. The Spread control adjusts the lens angle, while the Sharpness control adjusts the
See Info Palette on page 4-17 for further details.

The color of the spot light pyramid is set in the Preferences dialog. If the color chosen is
(default) light markers take on the color of light they represent. See Preferences on page 3-5 
for further details. 
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υ  Walls

The Walls plug-in is used to create rooms other than those with four regular walls. Walls
drawn vertical to the grid and resting on the grid.

1. Select the Walls plug-in from the Tools palette. The view will change to show an 
orthogonal, top view.

2. Click in the document at the point you wish to start drawing a wall. Holding down 
mouse button, drag along one of the constrainer lines that display to draw the wa

Note: Walls are drawn at multiples of 45 degree angles by default. Holding down th
Control key allows unconstrained angled walls. 
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3. Click at the point you want the wall to end. The Edit options dialog displays:

• If you have drawn the wall to exactly the correct length, and the default settings fo
height and thickness of the wall are correct, click OK.

• To change any of the wall’s dimensions, enter new values in the Length, Start He
End Height, Wall Thickness or Angle of Wall fields and click OK.

• If this is the last wall to be drawn click on the Done button.

• To enter the wall again, click the cancel button.

• To prevent this dialog from displaying, hold the Option key down when clicking o
the point you want the wall to end.

4. After closing the Edit options dialog, draw the next wall by dragging along one of 
constrainer lines displayed:
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5. Click at the point you want the wall to end. The Edit options dialog will display aga

6. Continue drawing further walls in the same way, adjusting the height, thickness a
angle of the walls as required.

While creating walls, if the cursor is aligned with another wall corner, an alignment
will display showing the alignment, and the cursor will change to a hollow cross.

Press the delete key at any time while entering walls to delete the wall currently b
entered. The cursor will move back to the previously entered wall.

7. When the last wall is drawn, click on the Done button in the Edit options dialog. T
view will revert to the previous view and the walls will display as specified. If the w
are the first items drawn, the room will be automatically centred on the grid.
G-12
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To change the default settings for wall height and thickness for the Walls plug-in:

1. Hold down the Option key and select the Walls tool to display the Wall Options dia

2. Enter a value in the Wall thickness field to specify the default thickness for walls.

3. Enter a value in the Wall height(s) field to specify the default height of the walls.
G-13
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Appendix H

Plug-in Modifiers

Plug-in Modifiers are plug-in tools that are used to modify objects or the
scene in some way. When installed they are located in the Tools palette.
Table of Contents

Introduction H-2
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υ Introduction

 When loaded, plug-in modifiers appear in the Tools palette as shown below. 

υ Animation Edit Path

The Animation Edit Path plug-in is used to edit the path of an animation path and can al
used to scale and rotate sections of an Animation Path at specific points on its path.

Light Director

VR

Sun Direction

GravityScale Object

Orbit

Walkthrough View Finder

Animation Edit Path
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The  Animation Edit Path Dialog

To display the Animation Edit Path dialog, click on the Animation Edit Path tool in the To
palette. 

Selecting an Animation Path to edit

With the Animation Edit Path tool selected, click on an animation path in the document w
dow. The selected path will display as a black line with handles at the ends and on the c

Types Of Point

• Vertex: A standard point used to define the beginning or end of a straight section of a
or line.

• Arc: A point on a section of a circle defined as the center point on the arc between tw
tex points.

• Spline: A point on a curve. The curve is defined automatically and cannot be edited e
by adjusting the points at either side of the spline point.

• Bezier: A point on a curve. Two Bezier handles allow the curve to be adjusted.

Vertex point handles display as squares, Bezier and spline point handles as diamonds, 
point handles as spheres.
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The Position, Scale or Twist radio buttons allow you to determine how the path will be m
ulated when selected with the Animation Edit Path tool.

• Position: If this option is chosen, path points manipulated.

• Scale: If this option is chosen, the amount of scale per point is manipulated.

• Twist: If this option is chosen, the amount of twist per point is manipulated.
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Selecting Points

Click on a handle to select it.

• A Vertex, Arc or Spline point will change color.

• A Bezier point will change color but has two additional handles to adjust the Bezier c

To select additional points, hold down the Shift key and click on another point. To desele
points, hold down the Shift key and click on a selected point.

Manipulating Points

• Vertex,  Arc, Spline: Click and drag on the point to move it. Adjust the scale or twist of t
section at that point by selecting the scale or twist radio button on the Animation Edit
dialog.

• Bezier: Click and drag on the point to move it. Adjust the scale or twist of the section 
that point by selecting the scale or twist radio button on the Animation Edit path dial
Click and drag on the Bezier handles to adjust the curve. Hold down the Option key
click and drag on the Bezier point or Bezier handles to break the Bezier curve.

Moving Points On The Path

To move a path handle of any type, click on it and drag.

• Select the Position radio button in the Animation Edit Path dialog.

• Click on the handle of the point on the animation path you wish to move.

• Drag the path handle to the new position.

• Use the Control key to change the axis used.

To move a point by precise values, click on the Relative to Path or Relative to World radi
ton in the Edit Path dialog and enter values in the x, y and z fields.

• Relative to Path: The selected point is moved to the values entered relative to the poin
the start of the path.

• Relative to World: The selected point is moved to the values entered relative to the gri

Adding Points To A Path

To add a point to a path, select two contiguous points on the path by clicking on the line
between them, or by holding down the Shift key and clicking on a second point. Click on
H-5
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Vertex, Arc, Spline or Bezier button in the Animation Edit Path dialog. A point of the spec
type will be added between the two points originally selected.

Alternatively, hold down the Option key, click on the path or an existing handle and drag
place a new Vertex point.

Note: An arc point can only be added between two vertex points.

Changing Points

To change a point to a different type, select the point then click on the Vertex, Arc, Spline
Bezier button in the Animation Edit Path dialog. The point will change to the type selecte

Note: An arc point can only be added between two vertex points.

υ Gravity

The Gravity plug-in is used to place objects on the grid.

Select the Gravity tool from the Tools palette. As the cursor is moved over the documen
dow it will change to a downward arrow. The active point is at the tip of the arrow. Click o
object and it will be moved so that its lowest point is placed on the grid.

If an object has been locked by clicking on the padlock icon in the top right corner of the
palette, or by selecting Lock from the Options menu, you will not be able to use the Gra
tool to drop the object to the grid. 

If the object position is locked only in the Y-axis, the Gravity tool will over-ride this restra
and can be used to drop the object to the grid. If you have several objects selected, som
which may be locked in the Y-axis, hold down the Shift key when using the Gravity tool to
vent these locked objects from being dropped to the grid.
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The Light Director plug-in is used to direct one or more spot lights in a particular directio

Select the light(s) to direct, then select the Light Director tool in the Tools palette. In the 
ment window, click at the place you want the lights to point. The light(s) will be rotated to
point at the place specified.

Lights can also be selected using the Light Director tool by selecting the tool and clicking
light. Hold down the Shift key and click on additional lights to increase the selection. Hol
down the Shift key and click on a selected light to remove it from the selection.

υ Orbit

The orbit plug-in is used to move the camera around a selected object.

Select the Orbit tool from the Tool palette. Move the cursor over the document window a
will change to a black diamond.

• Click on an object: drag the mouse left, right, up, or down and the view will orbit aroun
the center of the object’s bounding frame.

• Click on the grid: drag the mouse left, right, up, or down, and the view will orbit around 
center of the grid.

• Click in an empty area of the document window: drag the mouse left, right, up, or down, an
the camera will orbit around the center of the grid.

In all cases, the further you move the mouse from the point where you first clicked, the f
the view will move. Use of the option key will slow this rate of movement.
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υ Scale Object

The Scale plug-in is used to easily scale selected objects by percentage values.

1. Select the Scale Object tool from the Tool palette. The Scale Object dialog displa

2. To maintain an object’s proportions, ensure that the ALL checkbox remains checke

3. To scale an object without maintaining its proportions, uncheck the All checkbox. E
a value in percentage to scale the object in each of the x, y and z dimensions.

4. Click OK, and the object selected will be scaled by the specified value(s).
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υ Sun Direction

The Sun Direction plug-in is used to adjust the direction the sun light shines in.

The Sun Direction plug-in has the following options, displayed by selecting the Sun Dire
plug-in with the Option key pressed.

The Option dialog box allows you to enter values for both the angle of elevation of the sun
its position angle referenced from the clockwise direction, relative to the north.

When the Sun Direction plug-in is selected, and the Auto Show Plug-in Palettes prefere
enabled, the Lights palette is automatically opened so that you can make any necessary
changes to the way the scene is lit. See Lights on page D-26 for more details.

To adjust the position of the sun manually

1. Select the Sun Direction tool from the Tools palette.

2. The document window changes to Top view.

3.  The current direction the sunlight is shining in is depicted as a red line with a han
the end:
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4. Click on the handle and holding down the mouse button drag to change the positi
the source of the sun light.

5. Hold down the Control key as you drag to move the position of the source of the s
light closer or further away.

6. Movement of the sun direction line can be constrained to the X, Y and Z axes by h
ing down the Shift key.

7. Release the mouse button to drop the handle at its new location.

Note: The red direction line will not be visible with either the Microspot Preview Renderer
the Microspot Renderer.

υ View Finder

The View Finder tool allows you to click anywhere in the document to change the camer
entation to have that point at the center of the view.

υ VR

The VR plug-in is used to pan and tilt the camera using control mechanisms similar to th
found in QuickTime™ VR.

When the VR plug-in is selected, the NaviCam palette is automatically opened so that yo
use it to make changes to the camera position and view. See NaviCam on page D-27 for more
details.
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Select the VR tool from the Tools palette and click in your document window.

• To pan the camera (turn it left and right): hold down the mouse button and drag the m
left and right.

• To tilt the camera: hold down the mouse button and drag the mouse up and down. T
is limited to +/- 90°.

• To crab the camera (move it to the left or right): hold down the mouse button and the
mand key and drag the mouse left and right.

• To move the camera forwards and backwards: hold down the mouse button and the
mand key and drag the mouse up and down.

• To zoom in: hold down the Shift key.

• To zoom out: hold down the Control key.

As you move, the cursor changes to an arrow head pointing in the direction you are mov
all cases, the further you move the mouse from the point first clicked on, the faster the c
will move. Use of the option key will slow this rate of movement.

Alternatively, select the VR tool and use the arrow keys to move the camera:

• To pan the camera (turn it left and right): use the left and right arrow keys.

• To tilt the camera: use the up and down arrow keys. The tilt is limited to +/- 90°.

• To crab the camera (move it to the left or right): hold down the Command key and us
left and right arrow keys.

• To move the camera forwards and backwards: hold down the Command key and us
up and down arrow keys.
H-11
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υ Walkthrough

The Walkthrough plug-in is used to walk the camera through a scene.

Select the Walkthrough tool from the Tool palette. Click in your Interiors document windo
and the cursor will change to a black diamond. Drag the mouse to the left and right to m
those directions, or up to move forwards and down to move backwards. Use the left and
arrow keys to crab (move side to side), and the up and down arrow keys to tilt the came

As you move, the cursor changes to a black arrow head pointing in the direction you are
ing. In all cases, the further you move the mouse from the point first clicked on, the faste
camera will move.

Use of the option key will slow the rate of movement.
H-12
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Appendix I

Microspot Plug-in Renderers
Table of Contents

Introduction I-2

Selecting Microspot Renderers I-2

Renderer Options I-3
Renderer Options Dialog I-3
Shadows I-3

On/Off I-3
Resolution I-3
Soft Edges I-3

Anti-alias Image I-4
Anti-alias Image is Off I-4
Anti-alias Image is On I-4
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υ Introduction

The Microspot Renderer provides the following features in addition to those provided by 
active renderer: transparency; shadows; pixel level lighting calculations; image anti-alias
These features allow you to render a high quality, more realistic 3D scene — in particula
pixel level lighting calculations give more accurate representations of how lighting affect
faces.

The Microspot Preview Renderer is a limited version of the Microspot Renderer. The 
Microspot Preview Renderer allows a fast display of a scene rendered with Shadows an
edges. 

υ Selecting Microspot Renderers

The Microspot Renderer is accessed via the Renderer Options palette. Select Renderer 
from the Palettes menu to display this palette. Click on the Renderers pop-up menu, the
Microspot Renderer and the Microspot Preview Renderer. 
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υ Renderer Options

To change the Microspot Renderer options in Interiors select the Options button in the u
right corner of the palette or hold down the Option key when selecting the Microspot Ren

Renderer Options Dialog

The dialog provides controls to turn shadows on or off, adjust the resolution of the shado
soften the edges of the shadows and choose how much an image is anti-aliased. Click O
when you have set the rendering options you want to render the scene.

Shadows

On/Off

The Microspot Renderer and the Microspot Preview Renderer both create realistic shad
The Microspot Render has the option of not creating shadows when rendering.

Resolution

Increasing the sharpness of the shadows that are created 

Soft Edges

Turning on soft edges will soften the edges of the shadows, creating a more realistic sha
effect.
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Anti-alias Image

Use the anti-alias image checkbox to turn anti-aliasing on or off for the image. If image a
aliasing is turned off, the whole image is rendered at the same resolution. If image anti-a
is turned on, the edges of objects in the image are softened. Select the quality of render
Good, Better and Best radio buttons.

Anti-alias Image is Off

• Good: The image will be rendered at 72 dpi. A typical 640 x 480 render will require 2
Mb of RAM as an image buffer.

• Better: The image will be rendered at 144 dpi. A typical 640 x 480 render will require 
Mb of RAM as an image buffer.

• Best: The image will be rendered at 288 dpi. A typical 640 x 480 render will require 40
of RAM as an image buffer.

Anti-alias Image is On

• Good: The image will be rendered at 72 dpi, with soft edges at 288 dpi. A typical 640
480 render will require 2.5 Mb of RAM as an image buffer.

• Better: The image will be rendered at 72 dpi, with soft edges at 1152 dpi. A typical 64
480 render will require 2.5 Mb of RAM as an image buffer.

• Best: The image will be rendered at 144 dpi, with soft edges at 1152 dpi. A typical 64
480 render will require 10 Mb of RAM as an image buffer.
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Appendix J

Drag and Drop

This section discusses dragging and dropping colors, 3D objects, text, TIFF,
JPEG, GIF and Movie files to and from  Interiors documents.
Table of Contents

Drag Output J-2

Copy J-3

Drag Input J-3

Notes J-4
J-1

Return to main table of contents
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DRAG OUTPUT

You can drag a color from the Window control panel, Lights Palette or Info Palette to:

• A 3D object in  Interiors

• Another Lights Palette or Info Palette color or any other palette that includes color bu

• The Finder Desktop or a Folder window

• The Finder Trash Can

• An Interiors Library file

• A PICT-compatible, Drag & Drop aware application

You can drag a 3D object or an entire scene (by holding down the Option key and clickin
the background) to:

• Another view of the same file in  Interiors

• The window of a different file in Interiors

• A 3DMF-compatible, Drag & Drop aware application

• A PICT-compatible, Drag & Drop aware application

• The Finder Desktop or a Folder window

• The Finder Trash Can (to delete the object)

• A Interiors Library file
J-2
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COPY

When you copy selected items from a  an Interiors document, the following types of data
put on the Clipboard:

• A PICT of the selected items which is the same size as the front window

• A 3DMF as a single grouped item.

DRAG INPUT

Drag a PICT file from the Finder to:

• A 3D object to create a texture of the picture wrapped around the object

• The document window to make a background picture

• The document window to make a foreground picture (hold down the Control key whe
dropping the file)

• The grid to make a rectangle with a texture of the picture

Drag a text file from the Finder to:

• A 3D object to create a texture of the text wrapped around the object

• The background to make a background picture of the text

Drag a TIFF, JPEG GIF or Movie file from the Finder to:

• A 3D object to create a texture of the picture wrapped around the object.

Drag a 3DMF file from the Finder to:

• A  Interiors document (to import it)
J-3



 the 

 
or on 

place 
Drag a clippings file of the following type from the Finder:

• A PICT clipping (See Drag a PICT file from the Finder)

• 3DMF clipping (See Drag a 3DMF file from the Finder)

Drag  an Interiors color clipping file (created by dragging a color from a color button into
Finder) from the Finder to:

• A 3D object to change its color

• The background to change its color

• The Default Color button, to change the default color, as well as any selected items

• The Lights Palette to change the color of the appropriate light

• The Info Palette to change the color of the selected object/light

• Any other palette that includes color button.

NOTES

• To drag and drop locked items out of an Interiors document window, hold down the 
Option key.

• Holding down the Control key as you drag and drop an item onto an object or group
ungroups the object or group and places the item on just one surface of the object, 
one item in the group.

• Hold down the Option key as you drag a 3D object to leave a duplicate in the same 
as the original.
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Appendix K

Plug-in Directory

Lists the application’s plug-ins by name, provides details of the plug-in’s
type and status, and offers a brief description of its use.
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Appendix L

Command Key Table

Command key shortcuts can be used to perform many actions. The following
table lists those key combinations.
Table of Contents

Command Key Table L-2
File Menu L-2
Edit Menu L-2
View Menu L-2
Options Menu L-3
Plug-in Menu L-3
Help Menu L-3
L-1
Return to main table of contents



COMMAND KEY TABLE

Action Command Key

File Menu

New Command N

Open Command O

Close Command W

Save Command S

Print Command P

Quit Command Q

Edit Menu

Undo/Redo Command Z / F1

Cut Command X / F2

Copy Command C / F3

Paste Command V / F4

Delete Whole Object Backspace / Delete

Select All Command A

Duplicate Command D

Duplicate No Offset Command Shift D

Clone Command =

Clone No Offset Command Shift =

Group Command G

Ungroup Command U

View Menu

New Window Command K

Look At Selected Command 1
L-2



Home View Command 3 / Home

Custom (View) Command 0

Top (View) Command 5

Front (View) Command 8

Left (View) Command 4

Right (View) Command 6

Back (View) Command 2

Plan (View) Command 7

Last View Command 9 / End

Options Menu

Edit Item Command E

Lock Command L

Unlock Command Shift L

Grid Snap Command Y

Metric Command M

Inches Command I

Orbit Around View Command T

Plug-in Menu

Last Plug-in Command *

Help Menu

Online Manual Help

Action Command Key
L-3
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